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FDOTConnect
for

OpenRoads Designer
CADD Essentials

Description 

This course is an overview of the FDOT Connect WorkSpace for OpenRoads Designer. The goal of this 
course is to provide the user with an understanding of the FDOT WorkSpace for OpenRoads Designer and 
an overview of the essential elements of the FDOT design environment as a prerequisite for further FDOT 
CADD training courses.

Objectives 

This course includes but is not limited to:

•	 FDOTConnect Suite for OpenRoads Designer
•	 FDOTConnect desktop folder resources
•	 FDOTConnect design environment in OpenRoads Designer
•	 OpenRoads Designer worksets
•	 Navigating the OpenRoads Modeling Workflow and Ribbon
•	 Levels and Features in OpenRoads Designer
•	 Cells and Cell tools
•	 Reference Files in FDOT Connect for OpenRoads Designer

Prerequisites 
No prior CADD experience required, but some manual drafting or related CADD product experience is 
recommended.
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DOCUMENT STYLE

Style conventions used throughout the course guide are shown in the following table.

Item Convention Example

Menu names,        
Commands, and        
Ribbon Navigation

Bold 

(Names separated 

with > symbol)

	● General form is Workflow (when applicable) > Tab 
> Group > Tool

	● File > Open

	● File > Settings > User > Preferences

	● OpenBridge Modeler (Workflow) > FDOT > 
Actions > Create File

Window actions Bold 	● Click the Apply button. 

	● Click the Graphic Select button to the right of the 
Horizontal Alignment Include box. 

	● In the Segment Type list, click Lines.

Window field names Italic 	● Key in Hemfield Road in the Alignment Name 
field. 

	● Click the Graphic Select button to the right of the 
Horizontal Alignment Include field. 

	● In the Segment Type list, click Lines.

Key-ins Bold 	● Key in Hemfield Road in the Alignment Name 
field.

File names Italic 	● Open the file Working Graphics.dgn in the C:\Bent-
ley Training\GEOPAK 101\Project Setup\Practice\ 
folder.

File paths Underline 	● Open the file Working Graphics.dgn in the C:\Bent-
ley Training\GEOPAK 101\Project Setup\Practice\ 
folder.

New terms or emphasis Italic or Bold 	● The Template Library contains templates, which 
represent typical sections of the proposed road-
way.

	● The user is not to utilize this tool.
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1   FDOT AND OPENROADS DESIGNER
 
INTRODUCTION

This course was developed to introduce OpenRoads Designer Connect Edition users to the FDOT Connect 
WorkSpace for the design and development of Florida Department of Transportation (FDOT) projects. The 
intent is to cover the basics and give the user general knowledge of ORD with FDOT’s customization to assist 
the user in producing a product that is in compliance with the FDOT Computer Aided Design and Drafting 
(CADD) Standards.

OBJECTIVES
This chapter reviews FDOT Connect as a set of custom tools developed by FDOT for use with OpenRoads 
Designer and other Connect Edition applications.

•	 OpenRoads Designer and Connect Edition Applications

•	 The FDOT Connect suite

•	 FDOT Connect desktop folder

•	 FDOT Connect launch shortcuts

•	 Clearcrash and WorkSpace Doctor

•	 FDOT Connect support

•	 Additional FDOT Connect tools 

OPENROADS  DESIGNER  AND  CONNECT  EDITION  APPLICATIONS
Bentley OpenRoads Designer Connect Edition is the Bentley CADD platform chosen by FDOT for production 
of designs, plans, and models. Much like the previous platform MicroStation and Power GEOPAK, ORD 
uses the DGN file format.

 
NOTE    While DGN extension is still used, the ORD and Select Series DGN files are not compatible.
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FDOTConnect SUITE AND DESKTOP FOLDER
FDOT has created and provided a custom WorkSpace to standardize the OpenRoads Designer environment 
for FDOT projects to meet CADD standards. This WorkSpace determines how ORD displays on the screen 
and sets up certain default files and search paths. This WorkSpace, called FDOT Connect is also compatible 
with certified versions of OpenBridge Modeler, OpenBridge Designer and MicroStation Connect Edition.

The FDOT Connect Suite includes custom tools created

FDOT Connect creates a desktop folder and Windows menu application group. The desktop folder and 
menu group contain the same selection of launch shortcuts and shortcuts for FDOTConnect-related custom 
tools and applications.

Depending on what Connect Edition applications you have installed, FDOT Connect will create launch 
shortcuts for each of your installed applications to launch them in the FDOT WorkSpace mode. 

 
FDOTConnect LAUNCH SHORTCUTS
 
The FDOT Connect launch shortcuts allow the user to launch OpenRoads Designer, OpenBridge Designer, 
OpenBridge Modeler or MicroStation Connect Edition in the FDOT Connect WorkSpace mode depending 
on what applications are currently installed. It is important to consult the list of application versions that 
FDOT has certified for use with FDOTConnect. The example below shows the launch icons for all four of the 
supported applications. Double-clicking these shortcuts will launch the selected application in FDOT mode.
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FDOTConnect SUPPORT
The FDOT desktop folder and Windows menu application group also include icons for obtaining support for 
FDOT Connect and the FDOT workflow.

CADD GoToMeeting – When requesting support from the FDOT CADD office, it is sometimes 
necessary to connect via GoToMeeting for screensharing and troubleshooting. This shortcut provides 
access to a website where the user can enter a GoToMeeting ID number provided by a Support Specialist 
at the CADD Office.

CADD Support Communities – Bentley Communities is a web-based forum hosted by Bentley. 
Users can find community-based support and training information at this forum. This shortcut provides 
access to the FDOT CADD Support forum of Bentley Communities.

CADD Website – This shortcut provides access to the FDOT CADD Office website. The CADD Office 
website includes software downloads, training videos and training course guides.

Request CADD Support – This shortcut provides access to the FDOT CADD Office Issue Log 
portal. At this portal, the user can enter support request information and submit a support ticket. The 
dashboard for this portal is monitored throughout the day. An FDOT CADD Support Specialist will follow-up 
with the user to assist in resolving the support request.

CLEAR  CRASH  AND  WORKSPACE  DOCTOR
Clear Crash and WorkSpace Doctor are two custom applications created by the FDOT CADD Office for 
assisting in resolving CADD related issues.

Clear Crash – Clear Crash runs a batch file that ends process on any open Connect Edition 
applications. The intent of this tool is to expedite the closing of applications which may have become 
frozen or are in the process of crashing. This tool does not delete or remove any user data in the process. 
 
WorkSpace Doctor - WorkSpace Doctor dialog displays the different options you can select such as 
Clear Crash which closes any open instances of Connect Edition applications like ORD, OBM or OpenRoads 
Designer. You can also choose to have WorkSpace Doctor close Excel which sometimes gets stuck in the 
background when there is a problem with Linked Data Manager.



CADD Essentials 13

The remaining three options on the dialog are concerned with user-level settings files and temporary data. 
Clearing these files out can help to resolve some issues caused by file corruption. 
 
 

Below the selection options, the values for the System Environment Variables for FDOT_ORGANIZATION 
and FDOT_WORKSETS are listed. Selecting the ellipsis buttons to the left of these values will open these 
locations in Windows File Explorer. 

To the left of the RUN button, there is an ellipsis button to access a dialog displaying the versions of 
the Connect Edition applications you have installed and give access to the configuration files for these 
applications.
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ADDITIONAL FDOTConnect DESKTOP FOLDER TOOLS
FDOT also provides a number of additional shortcuts to custom tools that are commonly used in the FDOT 
workflow. These tools are Create Project, Designer Interface Quantities Builder, LandXML Visualizer, 
Project Validator, Summary Reports Builder, and XML Signing.

Create Project – This tool creates the ProjectProperties.XML file, a required deliverable for FDOT 
projects. Create Project populates the project information by accessing the FDOT Financial Management 
(FM) System. To access this system, the user must be connected to FDOT’s network. As a result, outside 
consultants are not able to access this system and create the ProjectProperties.XML file. To this end, the 
FDOT CADD Office has delegated this task to the District CADD Managers. Upon request, District CADD 
Managers will email the ProjectProperties.XML to a consultant.

Designer Interface Quantities Builder and Summary Reports Builder – These 
tools are part of the FDOT Automated Quantities workflow. For more information on how these tools are 
used, please see the FDOT Automated Quantities training guide.

LandXML Visualizer – This tool is used for on-screen visualization of the contents of LandXML files. 
LandXML Visualizer can be a useful part of the 3D model QC process.

Project Validator – Project Validator has replaced FileChecker as the project-level QC tool. With an 
intuitive interface and workflow, Project Validator creates an HTML-based report summarizing the QCProject 
report. For more information on this tool, see the General Resources section of the FDOT CADD Office 
website’s Posted Webinars page.

XML Signing – The FDOT XML Signing tool is used for applying digital signature certificates to XML 
files. For example, if a professional of record needs to sign a LandXML file, the FDOT XML Signing tool can 
be used.
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2  FDOTConnect FILES AND WORKSETS

OBJECTIVES
This chapter discusses launching FDOT Connect for OpenRoads Designer, creating Worksets and creating 
files. Highlights of this chapter include:

•	 Launching FDOT Connect for OpenRoads Designer

•	 Selecting the FDOT WorkSpace

•	 Creating Worksets and the Worksets folder

•	 Creating DGN files

•	 Opening and closing DGN files

•	 Switching from one Workset to another

INTRODUCTION
The previous chapter discussed the FDOT Connect desktop folder. This chapter explores using the launch 
icons to launch OpenRoads Designer and selecting the FDOT WorkSpace from the WorkSpace selection 
dropdown in the OpenRoads Designer backstage.

OpenRoads Designer organizes DON files into projects called Worksets. These Worksets are stored in 
the designated Workset folder. Inside the Workset folder, the OpenRoads Designer Worksets are further 
organized into subfolders based on WorkSpace. For example: the FDOT WorkSpace stores Worksets in 
a subfolder called FDOT inside the worksets folder. Inside this FDOT subfolder, you will find Worksets 
organized typically by FPID number. For each workset, there is a corresponding .DGNWS file and .CFG 
file. These two critical files have two main purposes: associating DGN files in the Workset with the Workset 
itself, and also Workset properties and sheet indexing.

Worksets are created using a Workset Template. FDOT delivers with FDOT Connect a Workset template 
called 0_WORKSET_TEMPLATE. This template is automatically copied to the FDOT subfolder of the 
Worksets folder during installation of FDOTConnect.

When creating a Workset using the 0_WORKSET_TEMPLATE, the standard FDOT folder structure is 
created, along with corresponding .DGNWS and CFG files and a _BlankFile.DGN at the root of the new 
Workset.

After selecting a Workset from the Workset selection dropdown menu in the backstage, the user can browse 
the Workset to select a DGN file to open. Only one DGN file can be opened at a time, and OpenRoads 
Designer provides a standard intuitive Windows-style interface for switching from one file to another inside 
of the Workset.
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LAUNCHING FDOTConnect FOR OPENROADS DESIGNER
 
To Launch FDOT Connect for OpenRoads Designer, double click the FDOT Connect for OpenRoads 
Designer shortcut on the desktop or inside the desktop folder.

OpenRoads Designer will launch, and the backstage will be displayed. 
 

 

In the OpenRoads Designer backstage, the user can select the FDOT WorkSpace from the WorkSpace 
selection menu. The FDOT WorkSpace will appear under the Custom Configuration section of the 
WorkSpace selection menu as shown below.
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After selecting the FDOT WorkSpace, the Worksets Selection menu will populate with a list of all worksets 
located in the Worksets folder. On the first launch of FDOT Connect for OpenRoads Designer, this 
means that the active workset shown will likely be the 0_WORKSET_TEMPLATE itself as shown below. 
 

Selecting the Workset Selection menu will display the list of Worksets. To be displayed in the list of 
Worksets, a Workset must be located in the FDOT subfolder of the Worksets folder and must also have a 
corresponding .DGNWS and .CFG file located in the FDOT subfolder of the Worksets folder.

Selecting a Workset from the Workset Selection menu will change the current active workset to the selected workset.

The user can now select the Browse button to Browse the current Workset. If any files in this Workset have 
been opened recently, they will display in the Recent Files section of the Backstage.



CADD Essentials 18

OPENROADS DESIGNER DGN FILES AND FDOT SEED FILES
Each design file (DGN) is created from a seed file. A seed file is a previously stored design file, with user 
specified settings, used as a template to create a new DGN. The Florida Department of Transportation 
(FDOT) has created seed files for use in production that have standard settings stored within them. Available 
seed files for the FDOT’s purposes are:

FDOT-ORD-SEED2D.DGN                                                        Contains settings to create a 2D design file.

FDOT-ORD-SEED3D.DGN                                                        Contains settings to create a 3D design file.

FDOT-ORD-KEYMAPSEED.DGN                                                   Contains settings to create a Key Sheet.

FDOT-ORD-RWSEED                                                               Contains settings to specific to Right of Way.

FDOT-ORD-TYPICALPACKAGESEED.DGN           Contains settings to create a Typical Section Package.

FDOT-ORD-STRUCTSEED2D,DGN                               Contains settings to create a 2D Structures design file.

FDOT-ORD-STRUCTSEED3D.DGN                               Contains settings to create a 3D Structures design file.

FDOT-OBM-KEYSHEETSEED.DGN             Contains settings to create a Key Sheet in OpenBridge (OBM)

FDOT-OBM-STRUCTURESSEED2D.DGN   Contains settings to create a 2D Structures design file in OBM.

FDOT-OBM-STRUCTURESSEED3D.DGN           Contains settings to create a 3D Structures design file in OBM. 
 
The DGN format contains smaller containers called models (not to be confused with 3D models which can 
be contained in these models). Each model consists of graphical elements such as arcs, lines and circles 
and is a unique drawing within the design file. Multiple models can exist within a DGN file, for example: 
roadway design profiles, plan and profile sheets and 3D models can all reside in separate models within 
the same design file.

Only one DGN file can be opened at a time in ORD, but other design files may be viewed by attaching them 
as reference files in the active design file.
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FDOTConnect CREATE FILE TOOL
FDOT has created a custom tool for creating new DGN files called the Create File tool. This tool can only 
be launched inside the OpenRoads Designer environment. New files should NOT be created by selecting 
“New File” from the backstage. Instead, the user should select a Workset, select Browse and locate the 
_BlankFile.DGN at the root of the active Workset folder structure.

Opening the _BlankFile.DGN allows the user to enter the FDOT WorkSpace in OpenRoads Designer and 
access the Create File tool.

The FDOT Create File tool is located on the FDOT Ribbon which can be accessed by selecting the 
OpenRoads Modeling workflow from the Workflow selection menu at the top left corner of the application 
Window and selecting the FDOT tab on the far right of the row of tabs on the Ribbon. Subsequent chapters 
will discuss the Workflow selection and the Ribbon in more detail.
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The Create File tool dialog displays the location of the current workset and has dropdown menus for 
selecting Discipline and File Group which allow the user to navigate different disciplines and create files in 
the proper location with the correct FDOT standard file naming convention.

File names for the selected discipline and file group are displayed in the middle portion of the Create File 
dialog as shown.
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Create File displays the output file name, allows for the addition of a file name modifier and automatically 
applies the correct sequence number to the end of the file name.

 

The dialog also displays the output folder (discipline folder) and the seed file used to create the file. There 
are dropdown menus for setting the Geographic Coordinate System based on the county. Finally, the 
Create File tool displays any additional actions that will be performed upon creation of the file, such as 
creating additional models in the file.

To create a design file, the user simply selects the Create-Open File button at the bottom of the dialog. The 
new file is created and opened in the FDOT WorkSpace. The dialog can now be dismissed by selecting the 
Close button at the bottom right of the Create File dialog.

LAUNCHING FDOTConnect AND SELECTING A WORKSET
Locate the FDOT Connect desktop folder and double-click the shortcut for FDOT Connect for 
OpenRoads Designer.
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The OpenRoads Designer backstage appears. From the WorkSpace selection menu, select FDOT.

The workset selection menu populates with 0_WORKSET_TEMPLATE. Select the workset selection menu 
and select the workset 22049555201.

Select the Browse button. The Open File dialog appears.
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Scroll to the bottom of the Workset folder structure and select _BlankFile.DGN. Select Open.

Locate the Workflow selection menu at the top left corner of the application window. Set the active workflow 
to OpenRoads Modeling.

On the row of tabs at the top of the OpenRoads Modeling Ribbon, select the FDOT tab and launch the 
Create File tool, located on the left side of the FDOT Ribbon.
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The Create File dialog appears. Note the current active workset location displayed in the Workset field of 
the Create File dialog.

Select ROADWAY discipline and Roadway Design Files group. Select the file name DSGNRD for 2D 
plan (Proposed) from the File Type portion of the dialog as shown below. 

NOTE      The output file name automatically selects the next available sequence number to 
append to the end of the file name DSGNRD02.DGN since our Workset already contains 
a DSGNRD01.DGN file. Set the county name to Wakulla and select the Create – Open File 
button at the bottom of the dialog. 
 

 
Create File now creates the DSGNRD02.DGN and opens the new file in the FDOT WorkSpace. Select 
Close to dismiss the Create File dialog.
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CREATING A NEW WORKSET IN FDOTConnect FOR 
OPENROADS DESIGNER 

 
Starting from the previous exercise, select the File menu from the top left corner of the application window.

Select Close from the column that appears on the left side of the application window to close the current 
file.

The OpenRoads Designer backstage appears. Select the Workset menu and select Create Workset.
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The Create Workset dialog appears. Populate the Name, Description, and Template fields as shown, being 
sure to select the 0_WORKSET_TEMPLATE as the template. Select OK at the bottom of the dialog to 
create the new Workset.

The new Workset is created and set active in the Workset selection menu. Once again, select the 
Browse button to browse to the root of the active Workset folder and open the _BlankFile.DGN. 
 

Accessing the FDOT Ribbon using the same steps from the previous exercise, locate the Explore Directories 
split button under the Resources section of the FDOT Ribbon and select Current Workset.
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A Windows File Explorer window displays with the contents of the current Workset location.

Select FDOT from the address bar in the Windows File Explorer window to navigate up one level to the 
FDOT subfolder in the Worksets folder.

Note the contents of the FDOT subfolder of the Worksets folder, including Workset folders and 
corresponding .DGNWS and .CFG files for each Workset.

 

Close Windows File Explorer and OpenRoads Designer.
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3 FDOTConnect DESIGN ENVIRONMENT

Unlike previous versions of the Bentley CADD software such as MicroStation Select Series or Power 
GEOPAK, OpenRoads Designer makes use of a Ribbon interface to access tools and applications. The 
Ribbon, situated along the top of the application window, can be configured for different workflows by 
selecting different options from the workflow selection menu.

FDOT has created a custom Ribbon configuration located under the FDOT tab when the Ribbon is set to 
OpenRoads Modeling workflow. The FDOT Ribbon displays a number of custom tools and resources that 
are used in the FDOT workflow.

To better understand the FDOT Connect and OpenRoads Designer design environment, it is important to 
familiarize yourself with the location of various common toolbars and menus. The diagram below will help 
you better navigate the design environment.

OPENROADS DESIGNER WORKFLOW SELECTION
 
As mentioned above, the OpenRoads Ribbon can be set for different workflow configurations by selecting 
a workflow from the menu located at the top left corner of the application window. For the purpose of this 
course, we will be focusing on the OpenRoads Modeling workflow setting as it provides access to both the 
FDOT tab as well as the majority of the tools used in the FDOT modeling process.

Additional workflows include OpenRoads Drawing Production, Survey, Geotechnical, Reality Modeling, 

Drawing, and Drainage and Utilities. 
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THE HOME RIBBON
The OpenRoads Designer Home Ribbon tab includes basic tools for navigating the design environment and 
accessing information and settings related to the current active design file.

 
 
Accessed from the OpenRoads Modeling workflow, the Home Ribbon has two important groups to become 
familiar with.

Attributes – This group includes dropdown menus for setting the active element attributes (Level, Color, 
Weight, Linestyle, etc.). Selecting attributes in the Attributes section before using a drawing tool in 
OpenRoads will cause the element drawn to be placed on the selected active level with the selected 
attributes. FDOT CADD standards specify ByLevel attributes for each level. The user need only select the 
desired level name, and the rest of the attributes will be automatically set for ByLevel.

Primary – This group includes the Primary tools or the tools that were previously located on the Primary 
Toolbar in Select Series and earlier versions of MicroStation and Power GEOPAK. These tools include:

•	 Explorer – A dialog that displays information about the contents of the active design file and any 
reference files that are attached to the active design file.

•	 Attach Tools – These tools include Reference files and Raster attachments. Selecting one of 
these tools will provide access to the respective References and Raster dialogs which display any 
attached files and allow the user to modify settings or attach additional files.

•	 Models – The models dialog displays the list of Models contained in the active design file. Models 
are containers inside a design file, and can be 2D or 3D and come in three different varieties: 
Design, Drawing and Sheet. Each DGN file can contain multiple models.

•	 Level Manager and Level Display – Level Manager displays the currently available levels in the 
active WorkSpace. Levels are attached through the FDOT WorkSpace configuration and stored in 
Level Library in DGNLIB format. Level Manager provides access to information about these levels. 
Level Display provides the user with a tool to turn levels on and off, changing how the elements in 
the active design file appears on screen.

•	 Properties – The properties tool provides the user with access to information about elements within 
the active design file. The user can either select an element and then select Properties, or select 
Properties first and then select an element. The result is a dialog box displaying the element’s 
properties.

•	 Key-In Browser – The Key-In Browser is used for entering commands into OpenRoads Designer 
by typing the commands into a window. The browser will populate all available commands which 
can be browser alphabetically.

FDOT RIBBON
The FDOT Ribbon is part of FDOT’s delivered customized WorkSpace. It is a custom ribbon configuration 
accessible from the FDOT tab under the OpenRoads Modeling workflow in OpenRoads Designer. The 
FDOT Ribbon displays useful tools and customized applications used for the FDOT design workflow.
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The FDOT Ribbon is organized into different groups: Selection, Actions, Cell Applications, Roadway, 
Traffic Plans, Quantities, Quality Control, Resources, and Help.

SELECTION - This group of the FDOT Ribbon includes selection tools such as the Element Selection 
tool and the Place Fence tool.

ACTIONS -  This group of the FDOT Ribbon includes the Create File tool, Level Filter settings, Linked 
Data Manager, and a Miscellaneous Tools split button, providing access to a number of custom FDOT tools.

Create File - This mentioned earlier in this training guide is used for creating DGN files according to 
FDOT standards with FDOT standard file names, seed files and proper discipline folder placement.
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Filters -  This split button allows the user to toggle the Level Filters on and off as well as toggle alignment 
annotations.

Linked Data Manager - This feature is used for linking spreadsheets and text from external Excel 
and Word documents. This tool is part of the Automated Quantities process for populating summary boxes.
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Miscellaneous Tools -  This split button provides access to Copy Reference Levels, Delete Element by 
Length, Place Professional Of Record, Rotate Text, Select Element by ID, and Set Coordinate System tools.

These are tools developed by FDOT to enhance the FDOT design process. 
 
 

Copy Reference Levels -  This is used to copy elements from selected references based on 
level. This is part of the 2D design process.
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Delete Element By Length -  This is used to delete short elements below a specified length. 
Additional options allow the deletion of elements by specific element type.

 
 

Place Professional of Record -  This places the Professional of Record or EOR information in 
the title block of a standard FDOT sheet border of standard sizes

Rotate Text -  This allows the user to select and rotate text at a specified angle

Select Element By ID -  This is used for locating and selecting elements by their element ID 
number.

Set Coordinate System - This sets the geographic coordinate system for the active DGN file. The 
user can select the coordinate system based on county name. Typically the geographic coordinate system 
for a file is set at the time of file creation by the Create File tool.
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Cell Apps -  This group of the FDOT Ribbon provides access to tools related to placing cells in 
OpenRoads Designer. Cells are pre-designed named groups of elements representing commonly placed 
items. Cells are stored in cell libraries delivered with the FDOT software.

Cell Libraries - This split button displays the cell libraries dialog, populated by the selected FDOT cell 
library, such as Roadway, Traffic Control, Traffic Plans, Right of Way, Structures or Survey. From the cell 
libraries dialog, a cell can be selected for placement as active cell or other methods of cell placement.

Cell Webpages - This split button provides access to the FDOT cell webpages. The FDOT Cell 
Webpages allow for placement of cells by selecting a cell through a graphical interface in a web-type 
browser.

Cell Search - This is a custom FDOT tool used for searching cell libraries based on a key word.



CADD Essentials 35

Cell Splatter - This is used to create a random distribution of the active cell within a defined area. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ROADWAY - This group of the FDOT Ribbon includes the FDOT Existing Features tool and the Attach 
Survey Reference Files tool.
 
 

 
 
These tools are covered in the Survey and Existing Features Modeling training.

Traffic Plans - This group of the FDOT Ribbon includes the FDOT Signs tool, the FDOT Pavement 
Marking tool and FDOT Traffic Planning tool. These tools are covered in the FDOT Traffic Plans training. 
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Quantity Takeoff Manager - This is FDOT’s tool for automating quantities. This tool is covered in 
the FDOT Automated Quantities Workflow training guide.

 
 
Quality Assurance -  This group of the FDOT Ribbon includes the FDOT QC tools. These tools are 
used to ensure compliance with FDOT CADD standards.

QC Quick - Launches the QC Quick tool which returns a percentage of compliancy for the active file. If 
the file is below 100% compliant, QC Quick will display a dialog allowing the user to navigate non-compliant 
elements and correct their level or symbology to meet compliance.

QC Project - Runs a batch QC process on a project or workset and generates a QC Project Report 
which is used by Project Validator to validate the compliancy of the project. 
 
 
QC Stop  -  Turns of the automatic QC process that runs each time a file is closed in FDOTConnect. 
After selecting QC Stop, the QC tool will not run for the current session. Closing FDOT Connect and 
relaunching will reactivate QC.
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RESOURCES -  This group of the FDOT Ribbon provides the user with access to many useful 
resources both locally and online.

Explore Directories - This split button provides access to the Current Workset folder and the FDOT 
Connect folder. Selecting either of these options will open the respective folder in a Windows File Explorer 
window.

FDOT Links -  These consists of links to useful FDOT resources on the FDOT website including the 
CADD Manual, Design Manual (FDM) and other useful pages.
 
Web Links - Provides access to useful transportation related information outside of FDOT, 
such as AASHTO, the Manual for Uniform Traffic Control Devices, SHSM and ADA. The HELP 
group of the FDOT Ribbon provides access to CADD support and other troubleshooting resources. 

 
 
 
 
 
 
CADD Support - Button includes links to email the FDOT CADD Office for CADD Support. This 
email goes to a number of support specialists in the CADD Office who can assist you with your CADD-
related inquiries.  There is also a link for CADD GoToMeeting which takes you directly to a website where 
you can enter a GoToMeeting ID number to connect with one of our CADD Support Specialists. Once 
you contact one of the CADD Support Specialists, they can provide you with an ID number to connect. 
 

 
 
 
There is also a link to the CADD Website and a link to Request CADD Support which takes you directly to 
our web-based CADD Support portal where you can log a ticket to request support.
 
WorkSpace Doctor - is a tool developed by FDOT that can help resolve some CADD-related 
issues that are caused by corruption of temporary user data configurations and preference files. If you are 
experiencing unexpected performance issues in OpenRoads Designer, WorkSpace Doctor may be able to 
resolve the issue.
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NOTE    (WorkSpace Doctor can also be launched from the shortcut in the FDOT Connect 
desktop folder).

 
 
 

 
WorkSpace Doctor dialog - Displays the different options you can select such as Clear 
Crash which closes any open instances of Connect Edition applications like ORD, OBM or OpenRoads 
Designer. You can also choose to have WorkSpace Doctor close Excel which sometimes gets stuck in the 
background when there is a problem with Linked Data Manager. 

The remaining three options on the dialog are concerned with user-level settings files and temporary data. 
Clearing these files out can help to resolve some issues caused by file corruption. 
Below the selection options, the values for the System Environment Variables for FDOT_ORGANIZATION 
and FDOT_WORKSETS are listed. Selecting the ellipsis buttons to the left of these values will open these 
locations in Windows File Explorer. 

To the left of the RUN button, there is an ellipsis button to access a dialog displaying the versions of 
the Connect Edition applications you have installed and give access to the configuration files for these 
applications.  
 
 

 
 
About - This button on the far right of the FDOT Ribbon displays the contents of the VERSION.TXT 
file which is stored at the root of the FDOT Connect installation folder. This text lists the current installed 
version of FDOTConnect, the release data and the versions of the software that this release is certified for 
use with.

NOTE   (Versions displayed in this dialog are the certified versions,and thisdialog does not 
necessarily reflect the versions that are currently installed on the machine in question). 
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For a list of currently supported software Current Supported Versions (fdot.gov) 
Above the FDOT Ribbon on the far right of the application window is a search field. This search field can 
be used to search for tools included in the OpenRoads Designer application if they are not immediately 
accessible from the current ribbon configuration. This can be very useful for users who know the name of 
the tool that they need, but do not know where it is located within the application.
 

 
 
 

NOTE      Do not use the F4 as shown in the FDOTConnect WorkSpace, it is used for another function. 

 
OPENROADS DESIGNER HELP AND SUPPORT
To access OpenRoads Designer Help, select FILE from the top left corner of the OpenRoads Designer 
application window. The backstage appears. Locate the HELP link towards the bottom left of the screen.

This launches the OpenRoads Designer Help screen which provides access to the Help Contents, 
CONNECT Advisor, Bentley Institute, Bentley Communities, Product Support and other options.

https://www.fdot.gov/cadd/main/version/currentversions.shtm
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CONNECT ADVISOR
Another helpful application that launches from within OpenRoads Designer is CONNECT Advisor. CONNECT 
Advisor can be accessed from the Help screen as previously mentioned, or by using the OpenRoads 
Designer Ribbon search field at the top right of the application window.
 
 
 

 

 
CONNECT Advisor provides searchable help, access to recent online information from Bentley, links to 
Bentley LEARN and training videos on YouTube as well as Contextual Help that allows the user to find help 
with whatever tool they are currently using.
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VIEW/APPLICATION WINDOW
The View Window is the area where the design elements are displayed. OpenRoads Designer allows a 
maximum of eight view windows to be open at any one time. The arrangement of the view windows can be 
customized within the application window.

VIEW CONTROLS 
Each view window has its own view controls to View Attributes, Update View, Zoom In/Out, Window Area, 
Fit, Rotate, Pan, View Previous and Next, Copy, Display Mode, Clip Volume and Mask. By default these 
are located at the top left of the OpenRoads Designer view window. 
 
NOTE       View controls are discussed in detail in Chapter 4. 
 

VIEW GROUP TOOLBOX
A View Group is a named collection of eight view windows which allows for the set up of the desktop to 
display preferences including number of open view windows, window size and view orientation. Each view 
group is associated with a model making it easy to access and navigate through different models in the 
active DGN file, via the View Group drop-down menu. By default this is docked at the bottom of the Layout 
Dialog above the Status Bar.
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ACCUDRAW TOOL SETTINGS

This is used to facilitate data point entry. The AccuDraw Tool Settings opens or closes when clicking the 
AccuDraw icon on the Primary Tools toolbox. If using the default Function key menu, pressing <F11> opens 
the AccuDraw Tool Settings. If it is already docked or open, pressing <F11> sends focus to the AccuDraw 
Tool Settings.

 
 
 
 

(AccuDraw Floating)

(AccuDraw Docked)

STATUS BAR

 
 
The Status Bar is located across the bottom of the screen layout and provides prompts, context-sensitive 
assistance, and some interactive functionality, which are described next. The label for the Status will 
display by hovering the cursor over any box. The user may customize the Status Bar by right-clicking on 
it to open a check list of options to check on or off for display.
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Selected Tool > Prompt - Shows the name of the selected tool or view control and (usually) a 
prompt for the next step in the normal procedure for using it. 
 
 
Message Center - Shows the system message information. Clicking in the Message Center portion 
of the status bar (field following the >Prompt) opens the Message Center window. This window contains a 
running log of system messages and any further description about the message if applicable. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Snap Mode - Shows the type of snap selected with the associated icon. Clicking the Snap Mode field 
displays the available snap modes. 
 

 

Active Locks -  This icon provides access to the Locks submenus. (It does not indicate status 
information.) 
 

 
 
Active Level - This area indicates the Active Level setting.  Clicking the Active Level field opens the 
Level Manager dialog, which is used to control level display and level symbology for the open DGN file 
and attached references. 
 
 
Selection Set - If shown, indicates elements are selected and displays the number of selected 
elements.  If no elements are selected, this field on the Status Bar is blank.  Clicking the status bar when 
it shows the number of selected elements opens a pop-up menu containing the following items: 
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4  VIEWING & ZOOMING

OBJECTIVES

This chapter covers all the viewing tools available in OpenRoads Designer including:

•	 View Windows

•	 View Preferences

•	 View Groups

•	 View Controls

•	 Saved Views

•	 Dynamic Views

INTRODUCTION 

As a drawing becomes more and more complex, it may be useful to open multiple view windows. OpenRoads 
Designer can have as many as eight drawing view windows open at one time. Opening multiple view 
windows allows users to focus on details, as well as an overview of the design, without getting lost in 
between. The view currently being worked in is known as the Active View and indicated by a highlighted 
title bar.

VIEW WINDOWS
A View window in OpenRoads Designer is commonly referred to as a view. Each view functions independently 
without affecting other views. They contain their own attribute settings with independent zoom, pan and 
rotate capabilities. Each can be resized or relocated independently by Clicking and Dragging the cursor 
at any edge of the view or on the title bar.

View controls are located at the top left of each view window.

These tools include zooming, panning and rotating tools as well as View Attributes tools.

VIEW CONTROL TOOLS
View Attributes - Opens the View Attributes dialog to adjust view attribute settings. 

View Display Mode - Sets the view display mode from the list of display styles or from the 
Display Styles dialog. 
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Adjust View Brightness - Applies scene lighting to a view and adjust brightness of shaded views. 

 
 
Update View - Refreshes (redraws) the current view to display elements correctly. 

 
Zoom In - Increases the magnification of a design by a user specified Zoom Ratio. 

Zoom Out - Decreases the magnification of a design by a user specified Zoom Ratio. 

Window Area - Magnifies an area of the design by a user defined window. 

Fit View - Display all displayable elements in the active design and attached references in a view. 

View Rotation - Opens the View Rotation toolbox and rotates/un-rotates the view. 

Pan View - Views a different part of the design without changing the view magnification. 

View Previous - Undoes the last viewing operation. 

View Next - Redoes the last undone viewing operation. 

Copy View - Copies content from one view window to another. 

Apply or Modify Clip - Opens the Clip Volume toolbox and applies a clip volume to a view. 
Volume 
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Clip Mask - Applies a clip mask to a view. 
 
 

VIEW GROUPS

A View Group is a named collection of eight view windows which allows for the setup of the desktop to 
display preferences including number of open view windows, window size and view orientation. Each view 
group is associated with a model making it easy to access and navigate through different models in the 
active DGN file. The View Groups dialog is located at the bottom left of the application

 
 
 
Tools on the View Groups tool bar include:
 
 
Previous Model - Accesses the previous model in the session history by clicking the left arrow.  
Alternatively, clicking the down arrow and selecting a previously accessed model from a drop-down list. 

 
 
Next Model - Accesses the next model in the session history by clicking the right arrow.  Alternatively, 
clicking the down arrow and selecting the next model from a drop-down list.
 

 
 
All Models Visited - Clicking the down arrow displays a drop-down list of all models accessed, from 
which a model can be selected to open.
 
 
 
View Groups - Drop-down list that displays the name of the view group as well as the model with which 
it is associated and allows for the selection of different view groups.

 
 

 
Manage View Groups  -    Creates, manages, edits, and deletes view groups. OpenRoads Designer allows 
an unlimited number of view groups to be saved. When users create a model, they are prompted to create a view 
group associated with that model by populating the Create a View Group checkbox in the Create Model dialog. 
 
 

 
 
Create View Group - Opens the Create View Group dialog to specify a name and description for the 
new view group.
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Edit View Group Properties - Opens the View Group Properties dialog to edit the name and 
description of the selectedview group.

Delete View Group - Deletes the currently selected view group.

List Box - Displays a complete list of all view groups for all models in the design file. The active view 
group is highlighted in green.

Apply - Applies the selected view group to OpenRoads Designer, opens the views in that view group 
and activates the model associated with the view group.

Close - Closes the Manage View Groups dialog.

Toggles - Click the numbered buttons to open or close individual view windows (equivalent to choosing 
the numbered items in the Window menu’s Views submenu.) The numbered button grouping is also 
present in various other dialogs, such as the References and the Level Manager dialog (Settings > Level > 
Manager). 
 
 

VIEW ATTRIBUTES 
The View Attributes dialog contains a series of toggles that allow users to set view attributes that affect 
whether and how certain types and classes of elements are displayed and whether certain drawing aids 
are displayed.

Each view can have its own view attributes settings and the view number at the top of the View Attributes 
dialog determines which view window the settings are applied to when the Apply to selected view button 
is selected. Selecting the Apply to open views button applies the current settings to all open view 
windows.

View Attributes are saved with the design file settings. To save changes to the View Attributes, select the 
menu option File > Save Settings.

The View Attributes dialog can be invoked from the View Control toolbox. Select the down arrow of the

View Attribute  icon to display a temporary popup of the View Attributes <OR> click on the View 
Attribute icon to open a floating View Attributes dialog.
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View Number - Sets the view for which attribute settings are displayed. 

 
 
Apply to Open Views - If on, any settings changes are applied to all the open views. 
 
 
Apply to Selected Views - If on, any settings changes are applied to selected open views. 

ACS Triad - If on, a coordinate triad representing the Active Auxiliary Coordinate System (ACS) 
displays. The ACS is controlled using the Auxiliary Coordinates dialog, which is opened by choosing 
Auxiliary Coordinates from the Utilities menu.

Background - If on, the background displays.

Boundary Display - Controls whether the boundaries of the clip volume are displayed for a given 
view, as well as reference clip boundaries 
 
Camera - If on, the view camera is on for the view. Applies to 3D designs only. This control is disabled 
(dimmed) if the active DGN file is 2D. 
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Clip Back - Toggles the display of elements and parts of elements located outside a 3D view’s clipping 
planes. If on, a back clipping plane is active in a view. 
 
Clip Front - Enables toggling the display of elements and parts of elements located outside a 3D 
view’s clipping planes. If on, a front clipping plane is active in a view. 
 
Clip Volume - Toggles the display of elements and parts of elements located outside a defined 
Clip Volume for a given view. If on, and a clip volume has been applied to the view, the view volume is 
restricted to the defined volume. If no clip volume has been applied to the view, it has no effect. 
 
Constructions - If on, construction elements (those with the Class attribute of Construction) display. 
Constructions typically are turned off in a view before plotting or rendering. 
 
Dimensions - If on, dimension elements display. Turning Dimensions off can decrease view update 
time. 
 
Data Fields - If on, enter data fields are displayed. 
 
Display Set - If on, display of elements is restricted to only those elements in the current display set. 
 
Fast Cells - If on, cells display as outlines. Turning Fast Cells on decreases view update time. 
 
Fast Curves - If on, curve elements display as line strings (with line segments connecting the 
vertices). If off, curves are smooth. 
 
Fill - If on, solid, closed elements with Fill Type of None or Opaque and text characters in a filled font 
display with color fill. 
 
Grid - If on, the grid displays. Its uniformly placed dots (grid points) and crosses (grid references) 
provide an indication of distances as a visual aid and a means of facilitating drawing precision with Grid 
Lock. 
 
Level - If on, level symbology overrides — the override color, numbered line style, line 
 
Overrides - weight, and material associated with each level — display in the view, instead of the 
color, numbered line style, and line weight of each element. 

Line Styles - If on, elements display with their custom line style, if they have one. If off, all elements 
with custom line styles display with the standard solid line style (0). Turning Line Styles off can decrease 
view update time. 

Line Weights - If on, elements display with their line weight. If off, all elements display with a line 
weight of zero. Turning Line Weights off can decrease view update time. 

Patterns - If on, pattern elements display. Turning Patterns off can decrease view update time. 
 
Pattern/Bump - If off, pattern and bump maps are not displayed for Phong or Smooth rendering. 

Maps - can reduce rendering times. 

Tags - If on, tags display in the selected view(s). 

Text - If on, text elements display. Since text elements take longer to display than most other elements, 
turning Text off can decrease view update time. 

Text Nodes - If on, empty text nodes displayed as small crosses with numeric identifiers. However, in 
most cases displaying text nodes is unnecessary. 

Transparency - If on, applies transparency to elements, references, and levels.
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Saved Views - Allows the recall of a saved, predefined view definition to a destination view window 
and allows use of the selected attributes in the saved view. 

Models - Displays the name of the model to which thesettings are applied. 
 
 

VIEW RIBBON

All of the View tools are also available from the Ribbon. In OpenRoads Modeling workflow, select the View tab 
to access the View tools ribbon.
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5  MODELS

OBJECTIVES
This chapter focuses on the use of Models and incorporating them into the FDOT environment. Topics 
include:

•	 Model Properties

•	 FDOT’s Use of Models

•	 Models Dialog

•	 Creating a Model

INTRODUCTION
OpenRoads Designer offers many features designed to facilitate the production of engineering information. 
One of the most beneficial of these features is Models.

Not to be confused with modeling or 3D models, the models referred to in this chapter are like containers 
within a DGN file. A design file is composed of models. When users draw or place elements in a design file, 
the elements are added to the active model. A model can be either 2D or 3D and is stored within the design 
file. When a design file is created from a seed file, an empty container setup is provided with a default model 
ready to create a design. If a 2D seed file is used, then the default setup is 2D, while a 3D seed file defaults 
to a 3D setup.

In 2D drafting, the OpenRoads Designer equivalent of a sheet of drafting paper is the design plane. Unlike 
a sheet of drafting paper, the design plane in a design file is extremely large and allows the user to draw 
models at full scale. To draw various elements in a model, the user enters data points. Each data point 
placed in the design plane has associated X (horizontal) and Y (vertical) positions or coordinates. The 
design plane is simply a Cartesian coordinate system upon which a model resides.

MODEL PROPERTIES
Each model also contains its own unique set of properties. Every model has its own set of eight views. The 
model whose views are displayed or available for display at a given time is the active model.

There are three types of models: Design Model, Sheet Model and Drawing Model.

Design Models - are model space in which the design is drawn and consists of design geometry 
which can be either 2D or 3D. A Design Model can also be used as a reference or placed as a cell. In 
OpenRoads Designer, an unlimited number of design models can be created in a design file. By default, 
the view windows of these models have black backgrounds.

Sheet Models - are used by FDOT to compose finished and annotated printable drawings. OpenRoads 
Designer allows an unlimited number of sheet models to be created in a design file. By default, the view 
windows of these models have white backgrounds.

Drawing Models -  are a subset of a 2D or 3D design model, used to apply annotations, dimensions, 
callouts, and other embellishments to a design. By default, the view windows of these models have gray 
backgrounds.
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FDOT’S USE OF MODELS

FDOT has implemented the use of models for combining dependent data into a single design file on a specific 
limited basis. Each type of model is used for its intended purpose. One example of the use of models in 
the FDOT WorkSpace is with FDOT alignment files. The Create File tool creates an additional model for 
superelevation when creating the alignment file. Once an alignment file is opened the models are readily 
available via the Models dialog.

View Groups- are predefined for each model within the alignment file These are created automatically 
in conjunction with the models and allow easy access to and switching between models.

In design files designated for sheets and plans development, additional sheet models are created during 
the creation of named boundaries. These additional models are based on the information stored in the 
sheet seed 
 
 

MODELS DIALOG 
 
When a design file is first created, it has a built-in Default design model described as Master Model ready 
to place elements. The OpenRoads Designer Models dialog allows users to create, edit, manage, and 
quickly switch between any model (including this Default model) in the design file. 
 
This dialog can be accessed from the Home ribbon under the Primary tools section by selecting the 
Models dialog icon. 
 
 
 

NOTE      This dialog can be docked at the top or bottom of the applications window. 
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The Models dialog contains several tools to allow the user to create, modify and manage models. These 
tools are outlined in the table below.

Create A New Model  - Opens the Create Model dialog, which is used to create a new Design or 
Sheet model in the open DGN file. Design models generally contain design elements, while sheet models 
are used for plotting. 

 
Copy A Model - Opens the Copy Model dialog, which is used to make a copy in the open DGN file 
of the existing model selected in the list.

 
 
 
Edit Model Properties - Opens the Model Properties dialog, for the model selected in 
the list box. This dialog is used to modify properties of models contained in the open DGN file. 
 
 
 
 
Delete Models - Deletes the model selected in the list box. The default model is present in every 
design file and cannot be deleted.
 
 
 
Import Model - Opens the Import Model From File dialog, which is similar to the Open dialog 
that allows selection of a DGN or DWG file from which to select the model to import. After clicking 
OK, the Select Models dialog opens allowing selection of the model to import into the open DGN file. 

 
 
Define Sheet Layout - (Sheet Models only) Opens the Define Sheet Layout dialog, allowing 
to set the Display status, and define the Size, Origin, and Rotation sheet layout parameters. 

 
 
List Filter - If on, displays a filter row in the list box that allows for defining a filter for any of the list 
columns. To define a filter, click on the required filter field and enter the filter parameters. For information on 
defining filters by string, integer or Boolean expressions, refer to the tables in Defining and Deleting Filters. 

 
 
List Box - Lists the models in the open DGN file. An icon displays next to the model name 
indicating whether the model is 2D or 3D. Double-clicking a model here makes it the active model.  
 
The model name and description can be edited by triple-clicking on the selected model name in the list box. 
To copy, delete, or adjust properties of a model, it must first be selected here.
 
The columns displayed in the list box can be customized by right-clicking in the title row of the list box and using 
the menu to select which options are displayed.
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CREATING A MODEL
Design Models - The user can create one or more discrete models within a design files and move 
between various models using the Models dialog. Where a design file contains many models, filters 
can be set to display only particular models, but filters are not saved from one design session the next.

Sheet Models - Use to compose design drawings which typically consist of references of the design 
models. References can be from the open design file or from other design files on disk. As with the Design 
Models, the user can switch between Sheet Models using the Models dialog. In OpenRoads Designer, 
the Plans Development workflow discusses sheet model creation using the Named Boundary tools.

Drawing Models - Are the intermediates between the 3D design model and a printable Sheet Model. 
It is an unbound white space that contains one or more views of the design model. The Drawing Model can 
be used for centralizing annotations that need to be shared across multiple sheets. When a Drawing Model 
is attached to a sheet, the drawing model’s annotation scale is used as the attachment’s default detail scale.

FDOT supports the use of all three of these types of models for various purposes. For more information, 
please see the Plans Development Workflow training guide. 
 
When creating models in a design file, the user has an option to specify whether or not that model Can 
be placed as a cell. If this option is turned on, the model can be referenced as a model <OR> placed as 
a cell within another model. When referencing a model, the link to the original is maintained and any 
modifications to the original will reflect in the reference. When a model is placed as a cell, the link to the 
original is removed.
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Creating Models (Manually)

Open the file c:\worksets\FDOT\22049555201\roadway\algnrd01.dgn.

From the Primary Tools toolbox located at the top of the applications window, click the Models 	
 icon to open
the Models dialog.

From the Model dialog, select the Create a New Model    icon to open the Create Model Dialog.

Fill in the dialog as shown below. Click OK. Notice in the Models dialog that the list window updates with 
the new model named algnrd40. At the same time the model was created, OpenRoads Designer switched 
the design environment to the new model for work to begin.

file:///c:\worksets\FDOT\22049555201_CE\roadway\algnrd01.dgn.
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Repeat the sequence to create the Model Name algnrd200 with the Description: Alignment at 200 Scale. 
Click OK.

From the Models dialog, double-click the Default listing to switch back to the Default Model.

From the View Groups toolbox located at the bottom of the applications window, notice there is a new 
corresponding view group with names corresponding with each model created.

Close the Models dialog.
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6  LEVELS

OBJECTIVES
This chapter focuses on leveling functionality in OpenRoads, which is comprised of the following:

•	 Setting the Active Level

•	 Level Libraries

o	 By-Level Names

o	 By-Level Symbology

o	 Level Filters

•	 Level Manager
•	 Level Display

INTRODUCTION
A design file is made with basic building blocks called elements that are placed on a design plane within 
each model. Each element placed in a model is on a drawing Level. Levels are analogous to transparent 
overlays which can be combined in different ways to visualize different parts of a model. When creating a 
design, the user can use many Levels to organize drawing information intelligently. Each Level can have its 
own color, style, and weight symbology along with a number of other attributes.

FDOT has adopted a By-Level system utilizing FDOT Standard Level Libraries that define discipline specific 
Levels and associated color, style, and weight symbology for the production of all FDOT projects. These 
FDOT Standard Level Libraries are locked and cannot be modified by the user.

ORD provides for the management and display options for levels through Level Manager, Level Filters 
and Level Display applications. FDOT has utilized these options in the setup of their CADD Standards as 
discussed in the following sections.

SETTING THE ACTIVE LEVEL

While a design file has many levels available to the user, only one level is open for modification at any given 
time. This open level is referred to as the Active Level. All elements are created on the Active Level. It is 
important to change the Active Level to the desired level before placing elements. The level an element 
resides on may be changed later, but the best practice is to create it on the desired level to start with. The 
Active Level is the same in all views.
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The following are ways to set the Active Level:

The easiest way to set the Active Level is to click the Active Level combo box on the Attributes portion of 
the Ribbon under the Home tab. Click the Active Level combo box to display available levels. Choose the 
desired level to be set as the Active Level.

From the Level Display dialog, the user can also set the Active Level. The user can click on the Level

Display  icon on the Primary Tools toolbox to open the Level Display dialog. The Active Level is 
highlighted in the Level list and can be changed by double-clicking on any other level <OR> by right-clicking 
on the desired level and select Set Active from the popup menu.

 

From the Level Manager dialog, the user can also set the Active Level. The user can double-click the 
Active Level box in the OpenRoads Designer Status Bar to open Level Manager and then double-click on 
any level to set the Active Level.
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NOTE      If you are using the civil geometry drawing tools, which will be discussed later, selecting 
a Feature Definition from the Feature menu on the tool settings dialog will place new 
elements on the appropriate level; however, it will not change the Active Level set in the 
Attributes toolbox.

LEVEL  LIBRARIES
An OpenRoads Designer Level Library refers to a component of a DGN Library that contains a level 
structure; that is, one or more level definitions. New level libraries can be created; and new and existing 
level libraries can be attached, detached, imported, and exported using the Level Manager dialog. A level 
definition does not technically attach from the Level Library to a design file until it is used.

FDOT has created standard FDOT DGN Libraries (DGNLibs) within FDOT Connect to store FDOT Standards 
for: cells, levels, level filters, line styles, multi-line styles, text styles, dimension styles, element templates, 
menu customizations, customized tools, tool boxes, and tasks. Each FDOT DGNLib contains data that is 
shared throughout files and among users.

When a design file is opened in the FDOT WorkSpace in ORD, the corresponding FDOT Standards Level 
Libraries are automatically attached with preset FDOT Standard Filters activated. Only the valid levels from 
the attached libraries associated with the specific active design file are displayed for use.

BYLEVEL  NAMES
Each FDOT Standard defined in a Design Library (DGNLib) is identified by a unique Level Name. When used 
from a DGNLib, it is copied into the active design file and is given the same name. This allows for comparison 
of the local resource to the FDOT DGNLib resource for compliancy to FDOT CADD Standards.

BYLEVEL  SYMBOLOGY
The standard FDOT Level Libraries define the CADD Levels for each Discipline with the associated ByLevel 
Color, ByLevel Line Style, and ByLevel Line Weight symbology. Designers are to use these standard FDOT 
Levels to assign each element within FDOT CADD design files.

The FDOT Levels and symbology are grouped and translated into specific QC Rules which are associated 
to each valid Standard Filename of each Discipline for the purpose of performing the Quality Control check 
for FDOT Standard compliancy of design files.

When using FDOT Connect and OpenRoads Designer to create an FDOT drawing, the color, line style and 
line weight attributes should be set to “ByLevel”. This setting allows the level to control these active attributes. 
This ensures that the levels comply with FDOT standards. FDOT levels are predefined and delivered in 
specific .dgnlib files. FDOT does not recommend overriding the ByLevel settings. To do so would result 
in non-standard design files that would not be acceptable in FDOT Project submittals. Additionally, when 
drawing using the civil geometry tools, selecting the appropriate feature definition for an element is the 
recommended method to ensure that the element meets both By-Level compliancy as well as having the 
correct Feature information. This will be covered later in the training guide.
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LEVEL  FILTERS
OpenRoads Designer levels can be filtered at any time to make only specific levels within a Level Library 
available during the design process. FDOT utilizes the OpenRoads Designer level filters to combine level 
definitions within the FDOT Level Libraries into Filter groups.

FDOT created a Filter group called Standards that match the FDOT Standard Rule Files. Each Standard 
sub-filter is associated with an FDOT Standard filename. When a design file with an FDOT Standard 
filename is opened in OpenRoads Designer, only the FDOT Levels approved for use in that design file are 
displayed for selection.

As mentioned earlier, these level filters can be turned on and off from the FDOT Ribbon. 
 

LEVEL  MANAGER 
 
Level Manager is used to control level display and level symbology for the open DGN file and attached 
references. By default, the Level Manager includes a list of models, levels, and filters on the left, and a 
detail section of levels on the right. Multiple design files and/or reference attachments can be selected 
from the tree by holding the left mouse button down and dragging the cursor over the desired files. The 
levels for all the selected files display in the level list. 
 
As previously stated, FDOT has established and delivers Standard CADD Symbology Levels within 
a set of DGNLIBs. FDOT’s WorkSpace disables the Level Manager’s modification/creation functions 
of levels and does not allow users to create, delete, import, or export levels to ensure consistency in 
products submitted for FDOT Projects. Every level needed for creating FDOT drawings should already 
exist, including miscellaneous levels for “scratch” drawing. If a new level is desired, a request must be 
submitted to be addressed through the CADD Technical Advisory Committee (TAC) of the appropriate 
discipline. 
 
The Level Manager is accessed by selecting the Level Manager icon from the Primary section of the 
Home Ribbon. 

The Level Manager functions go beyond level editing, but provide much information to the user:
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MODEL,  LEVELS,  AND  FILTERS  LIST
In the pane to the left of the dialog, the Level Manager displays the Active Design File, Model with all 
the references; the All Levels attached and used within the open design file and all Filters available for 
use by the user. FDOT has developed many filters from the various level libraries to match the FDOT 
CADD Standards and delivers them with the FDOT CADD Software. Upon opening of any FDOT Standard 
filename within the FDOT WorkSpace, an associated standard filter will be automatically applied, displaying 
only those levels valid for the active design file. The filter function can be disabled and / or utilized by the 
user to further customize other filters to best aide in the design process.
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LEVELS  LIST 
As previously stated, FDOT associates each FDOT Standard Filename with a Standard Filter. This listing 
displays the attributes and properties of individual levels allowed for the selected file or reference. The 
highlighted level indicates the Active Level. Bolded items represent levels that have been used within the 
design file. The listing can be sorted by double-clicking any of the titles. The columns in this listing can be 
customized by right-clicking on the title bar and checking or un-checking available options.

NOTE      To display all levels used, regardless of validity, the user must turn off all filters by 
selecting none from the dropdown.

  
RIGHT-CLICK  POPUP

Level Manager has a right-click option to allow the user to Set Active Level, Jump To Active Level, and 
view Properties.
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LEVEL  DISPLAY
The Level Display dialog provides the ability to turn on and turn off levels in a model and to apply filters 
created in the Level Manager dialog.

This dialog can be accessed from the Primary section of the Home Ribbon. Select the Level Display

  icon. Note the down arrow next to the icon allows the Level Display to open in popup mode and 
automatically close when the cursor is moved away from the dialog.

Apply to Open Views  – If on, level display settings adjustments will apply to open views.  

 

Apply to Selected Views  – If on, level display settings adjustments will apply to the selected 

 
Change Level  – Opens the Change Level tool, used to display or lock a level. 

 
 
Show Target Tree - Changes the display of the Target Tree, used to set the target mode for level 
display settings changes or sets the model as a target. 

 
 
List Filter  – If the Show Level Name or Filters option menu is set to Level, this option will allow the 
user to set a Filter, named or defined on-the-fly, applied to level display. 

Show Level Name or Filters – Determines the contents of the List box. 
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Filters - Lists level filters defined in the open file (and in refernce attachments if they are selected in the 
target tree). 
 
Levels - Lists the levels in the open file (and in refernce attachments, if they are selected in the target 
tree). 
 
Dialog Properties – Pops up a Level Display dialog, used to set the properties of the Level Display 
dialog. 

Target Tree  – Used to select the target model for level display settings changes.  This tree control 
enables selection of the active model, another model in the open DGN file, or an attached reference in the 
open file or another file, as the target. 
 
Right-clicking on the active file or the reference files in the target tree area opens popup menus with the 
following options: 
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Levels (List box) – Lists the Levels (or filters if Show Level Names or Filters is set to Filters) in the 
target model. This listing has the same display, sorting, and function capabilities as the Level Manager. 

Right-clicking on the title bar opens a popup menu to customize the list display columns with the following 
options: 

Right-clicking within the listing opens popup menu with the following function options:
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WORKING WITH LEVELS 

CHANGE ATTRIBUTES  

 
Once an element is placed, the level on which it has been drawn or the symbology with which it was 
drawn can be changed if necessary. One tool that can be used to change the level on which an element is 
placed or the attributes with which it was placed is the Change Attributes tool.

The Change Attributes tool is accessed by selecting the icon shown below from the Modify section of the 
Drawing tab on the OpenRoads Modeling Ribbon.

 
 
Change Element Attributes - Used to change an element(s) level, color, line style, line weight, 
or class. This tool may also be used to match one element’s attribute to another’s. 

From the Change Element Attributes tool setting dialog, the user can control what properties of an 
elements’ symbology are changed.  

Use Active Attributes - If on, active attributes are affected when the user changes or matches 
attribute settings. If off (default), the active attributes settings are not affected when the user changes or 
matches attribute settings.

Eyedropper icon (Match Element Attributes) - Used to match the element attributes 
of the element selected, and then use these settings to change the attributes of the next element(s) 
selected. 
 
If Use Active Attributes is on when clicking the eyedropper, the active attributes will change to match the 
element selected.

If Use Active Attributes is off when clicking the eyedropper, only the settings in the tool settings window 
change to match the element selected. The active attributes do not change.
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Level - If on, level is included when changing or matching settings.

Color - If on, color is included when changing or matching settings.

Style - If on, line style is included when changing or matching settings.

Weight - If on, line weight is included when changing or matching settings.

Transparency - If on, element transparency is included when changing or matching settings.

Priority - (2D only) If on, element priority, is included when changing or matching settings.

Class - If on, element class is included when changing or matching settings.

Use Fence - If on, the tool will modify the element(s) based on the fence and fence setting used. Note 
that this option is grayed out unless there is an active fence placed in the design file.

Make a Copy - If on, the element(s) are copied and the attributes of copy(s) are changed, but the 
attributes of the original are not changed. Turn this setting on in conjunction with the Level setting to copy 
an element from one level to another or from a reference to a master file level.

Change Entire Element - If on, the attributes for the entire element are changed. 
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EXERCISE OVERVIEW
Exercise 6.1Exercise 6.1     Reviewing Level Manager

1.	 Open the OpenRoads Designer file: c:\worksets\FDOT\22049555201\roadway\dsgnrd01.dgn.

2.	 From the Primary section of the Home tab on the OpenRoads Designer Ribbon, select the Level 
Manager icon.

3.	 The FDOT CADD Software delivery includes an FDOT WorkSpace with a preset Level Library that is 
locked, disallowing the user from creating new levels. Also included are preset FDOT Connect Level 
Filters that are automatically associated to all FDOT Standard Files. 

4.	 From Level Manager, move the cursor to hover over the Filter List icon. Note the Standards filter,

5.	 DSGNRD that has been automatically associated and displayed.

6.	 Select the Down Arrow to open the popup listing and then and scroll to the top to select (none).  The 
Level list pane updates with all available levels from the Level Libraries attached to the design file. 

file:///c:\worksets\FDOT\22049555201_CE\roadway\dsgnrd01.dgn.
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NOTE      Not all levels are embedded into the design file, only the levels used displayed in bold in 
the Level Manager.

7.	 From the Level List, click on the column titled Used to sort all the Levels used within the design file to 
the top of the list. The title may have to be toggled twice as the list can be sort ascending or descending. 
Select other column title headers and note how each sort ascending or descending.

8.	 Right-click the Level List and select Jump to Active Level from the popup menu. The Level List moves 
to and highlights the current Active Level as displayed in the Attributes toolbar.
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9.	 From Model, Levels, and Filters List pane to the left of the window, expand the Filter sections by 
clicking the  icons. Note the listing of preset FDOT Filters and what [Level Library] they are drawn 
from. 

10.	Expand the STANDARDS [FDOT_Standard_Features] parent filter by clicking the   icon. All the 
filters displayed match directly to the FDOT Standard Rules. Select the DSGNRD to display the 
FDOT Standard Levels allowable for use in the current active design file, dsgnrd01.dgn.
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SETTING THE ACTIVE LEVEL
1.	 Continuing with the dsgnrd01.dgn file and Level Manager

2.	 From the Attributes tools located on the Ribbon, set the Active Level to CurbBack.

3.	 Note in Level Manager that the Active Level is now displayed as CurbBack.

4.	 In Level Manager, double-click on the level CurbFace. The Active Level is now CurbFace.
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5.	 Finally, right-click on the level PavtAsphalt and select Set Active from the right-click pop-up menu.

NOTE    PavtAsphalt is now the current active level.

6.	 Close Level Manager and Exit OpenRoads Designer.
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7  BASIC DRAWING TOOLS

OBJECTIVES
This chapter reviews the understanding of the basic drawing tools provided in OpenRoads Designer, 
including:

•	 Placing Elements

•	 Tool Settings

•	 Basic Workflow

•	 Linear Task

•	 Polygons Task

•	 Arcs Task

•	 Ellipsis Task

•	 Undo and Redo

INTRODUCTION
OpenRoads Designer has many drawing tools (or tools, for short). These tools are grouped for convenient 
selection on the Ribbon in their respective workflows.

Each open toolbox is either floating in its own window or docked to an edge of the application window. The 
arrangement of tools in a floating toolbox can be changed by resizing its window. Tools are represented in 
toolboxes by icons. For simplicity, the term Tool is used to refer both to a tool and its icon.

Only one tool can be selected at a time, for example, the Place Line tool or the Element Selector tool.

The basic drawing tools that are discussed in this training guide are located under the OpenRoads Drawing 
Production workflow under the Drawing tab on the Ribbon. These tools place, manipulate and modify basic 
linework elements placed with only symbology attributes. As discussed in the previous chapter, many of the 
elements used in the FDOT workflow include additional Feature Definition (or Feature) attributes for use in 
modeling and automated quantities. These featurized elements are placed using a different set of drawing 
tools. This course gives the user an introduction to the basic drawing tools with the understanding that the 
feature-driven Geometry tools function in a similar manner.

The featurized Geometry tools are covered in the FDOT Basic 2D Roadway Design training guide.
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PLACING ELEMENTS
In OpenRoads Designer and MicroStation Connect Edition, the objects drawn, or placed, in a model, lines, 
polygons, circles, text, etc., are called Elements. Each element has several attributes that define the 
element:

•	 Level

•	 Color

•	 Line weight

•	 Line style

•	 Fill color (for closed elements)

•	 Class

•	 Transparency

•	 Priority (2D only, for display) 

FDOT defines the CADD level/symbology Standards for Level, Color, Line Weight and Line Style and has 
incorporated these standards in the FDOT tools delivered within the FDOT WorkSpace. The users need 
only to utilize these tools to create elements set to the required level/symbology to pass compliancy with 
the FDOT CADD Standards.

In OpenRoads Designer the left mouse button is mapped to a logical button called the Data button, which 
sends a type of graphic input called a data point when pressed. The right-hand mouse button is mapped 
to the Reset button, which is used for resetting and for accessing Reset pop-up menu and View Control 
pop-up menu. The pressing of both right and left hand mouse buttons at the same time, called a button 
“chord”, invokes the Tentative button, which is used to enter tentative snap points. If a three button mouse 
is available, it can have the center button mapped as the tentative button.

When selecting an element within a design file <OR> or when placing the cursor into the design plane of a 
design file to create or manipulate an element, an element is being positioned to a specific location. These 
positioning locations are called data points. A data point is a graphic input that, depending on the context:

•	 Designates a point in a design (for element placement or selection, for example).

•	 Designates the view in which it is entered (for fitting or updating, for example).

•	 Accepts an operation (deleting an element, for example), rather than rejecting it. 

While dragging to enter data points is fast and easy, the preferred technique is clicking to enter each data 
point for more precise accuracy.

TOOL SETTINGS
OpenRoads Designer has several aids to help to use tools. Notice a floating dialog whose title and contents 
change each time a tool or view control is selected. This dialog is the Tool Settings window. Almost every 
OpenRoads Designer tool has settings that affect how the tool works and can be controlled in this Tool Settings 
window. If closed, the window opens automatically when a tool with settings is selected. The status bar 
along the bottom border of the application window displays prompts and messages about the selected tool. 
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Rather than forcing the adjustment of a tool’s settings each time the tool is selected, tool settings remain 
in effect until changing them. This makes the product more efficient to use, but also means the active 
tool’s settings must be kept in mind or displayed on the screen.

Ordinarily upon selecting a tool, the settings are adjusted before entering any data points. However, some 
tool settings are not applicable until data points are entered.

For example, while using Place SmartLine, after entering three or more data points and then move the 
pointer near the location of the first data point, a check box labeled Closed Element will appear in the tool 
settings window, enabling to the placement of a polygon.

BASIC WORKFLOW
OpenRoads Designer has a basic workflow as a simple foundation to follow and remember when using 
drawing tools:

SIMPLE STEPS TO FOLLOW WHEN CREATING NEW DRAWING ELEMENTS

Set the Active Element Attributes - The recommended practice is to set the active element 
attributes first, even though, these can be changed after placement. It is advisable to always be aware of 
the active element attribute settings when placing elements.

FDOT CADD Standards are based on pre-determined By-Level settings. For FDOT projects, the Level 
attribute need only to be set and the Color, Line Style and Line Weight will automatically set to the By-
Level settings.

This step can be skipped if not placing an element or using a tool that does not rely on element attribute 
selection.

Select the Tool - All tools are located on the OpenRoads Designer Ribbon. Throughout the learning 
process, experiment with different tools and utilize the Undo and Redo functions as needed.

Adjust the Tool Settings - When selecting different tools, review each of the Tool Settings functions 
as the window changes. The OpenRoads Designer help document contains descriptions of all tool settings. 
Connect Advisor can also be consulted for contextual help on any of these tools.

Follow the Status Bar Prompts - In the beginning, remember to follow the prompts in the 
OpenRoads Designer Status Bar located in the lower left corner of the application window. These tell how 
to proceed from step to step.
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ELEMENT PLACEMENT TOOLS
Lines are the most basic element in any design file. No matter what discipline is involved, linear elements 
play a large role in the basic geometry. The Linear Elements toolbox contains many tools that place linear 
elements into a design file.

Place SmartLine - Used to place a line, line string, shape, arc, or circle or a combination thereof as 
a complex element.

    

Place Line - Used to place or construct a line.   

Arc Tools - Contains tools for placing and modifying arcs and ellipsis.          

Ellipse Tools - Tools used for placing circles and ellipsis   

Polygon Tools - Tools used for placing blocks and other polygons    

Create Curves Tools - Tools used for creating B-splines and other types of curves 

Points Tools - Tools for placing points by various methods  

More Tools - Tools for placing multi-lines, stream lines, curves and other types of lines elements.   

Text Tools - Tools for placing text and notes   

Cell Tools - Tools for placing and modifying cells.  
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EXERCISE OVERVIEW

Exercise 7.1Exercise 7.1     Placing Linear Elements

PLACE LINE
1.	 Open the File c:\e\projects\22049555201\DSNGRD01.dgn.

2.	 Set the Workflow to OpenRoads Modeling and select the Drawing tab on the Ribbon.

3.	 Zoom into the location of Station 32+00 to 34+00 near the intersection of the design. This is the 
location where a sidewalk will be placed along the left side of the roadway. (Note: In the standard FDOT 
workflow for 3D modeling, this line would be placed with the OpenRoads Designer Geometry Tools. For 
the purpose of this exercise, we will be using the basic drawing tools).

4.	 Set the Active Element Attributes from the Attributes dialog on the OpenRoads Designer Ribbon, 
change the Active Level to SidewalkFront.

5.	 Select the Place Line Tool from the Placement Tools section of the Ribbon

6.	 Adjust the Tool Settings from the Place Line Tool Settings box by selecting the Length checkbox and 
enter 200 as shown below.

file:///c:\e\projects\22049555201_CE\DSNGRD01.DGN.
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7.	 Follow the OpenRoads Designer Status Bar Prompts at the bottom left of the application window to 
place a line along the shoulder along the left side of the roadway between Stations 30+00 and 32+00.

ü	Place Line > Identify start of line – place a data point next to the shoulder starting the line at 
Station 30+00.

ü	Place Line > Identify end of line –place another data point to end the line at Station 32+00. 

8.	 Right click on the mouse to reset and end process.

9.	 Repeat steps 3 – 7 to set the Back of Sidewalk. From the Attributes toolbar, change the Active Level to 
SidewalkBack and place another line offset from the front of the side walk.
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UNDO AND REDO 
 
No matter how meticulous a user is, errors occur when creating a design. OpenRoads Designer stores commands in 
an Undo buffer that goes back a single step or multiple steps when a mistake is made. Redo is the opposite of undo. 
 
There is no limit to the number of Undos that can be performed. After making the selection to Undo a 
drawing operation, the operation previous to the negated operation can be undone. A series of previous 
operations can be undone by repeatedly choosing Undo. Undo function cannot be used for settings changes. 
 
More advanced undo functions can be accessed through the OpenRoads Designer menu option Edit: 
 

 
Undo -  Negates the last drawing operation. Identifies the last placed element in the menu option. 
 
Undo Other > All - Opens an alert box that lets the user negate all of the drawing operations recorded 
in the Undo buffer.
 
 
Undo Other > To Mark -  Negates drawing operations performed after a mark was set by choosing 
Set Mark from the Edit menu.
 
 
Redo - Negates the last Undo operation. Identifies the last undone element in the menu option. 
 
Set Mark - Sets a mark in the undo buffer back to which subsequent drawing operations can be undone.
 

HINT        Each undo operation is a single re-doable operation regardless of the number of 
negated drawing operations. 
 

NOTE      Any Compression done on the design will delete the Undo/Redo buffers.
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8  CHANGING ELEMENTS

OBJECTIVES
Refining designs usually requires manipulating elements after they have been created. This chapter 
discusses the manipulation and modification tools provided in OpenRoads Designer.

•	 Identifying Elements

•	 Selecting Elements

•	 Manipulate Elements

•	 Modify Elements

•	 Deleting Elements

INTRODUCTION
Many times OpenRoads users are not called on to create new designs, but edit existing ones. The user 
needs tools that allow manipulation and modification of existing geometry. OpenRoads Designer provides 
many tools dedicated to changing existing graphic elements.

SELECTING ELEMENTS 
 
For operations performed on existing elements within a design file, the user must have the ability to 
select those elements. This can be done using the Element Selection Tool. This tool is located at the 
far left end of the FDOT tab on the OpenRoads Designer Ribbon and other logical locations in different 
Workflows on the Ribbon.

After activating the Element Selection Tool, the cursor can be placed over an element, and the element 
can then be selected by entering a data point.

The Element Selection tool allows for the selection of multiple elements to be worked on as a temporary 
group by a variety of means. Using this method, for example, move, copy, rotate, or scale multiple elements 
together. By default, selected elements are bracketed with squares called handles. If any elements are 
selected, an arrowhead icon is displayed in the status bar. The number to the right of the icon is the number 
of selected elements. 
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MANIPULATE ELEMENTS 
 
The OpenRoads Designer Manipulate Tools are located on the Drawing tab of the OpenRoads Modeling 
Workflow on the Ribbon. This section contains tools that are used to copy, move, resize, rotate, mirror, 
and perform other manipulations on elements. These tools can be used in conjunction with the Element 
Selection tool, to manipulate groups of elements simultaneously. Of course, they can also be used by 
themselves to manipulate single elements. 
 

NOTE       Used with the Element Selection tool, an element needs only to be right-clicked on to 
open a menu with options to copy, move, scale, rotate, mirror, delete, or display the 
properties for the selected element.

 
 
Move Element - Moves an element(s) 

. 
 
Copy Element - Copies an element(s). 

 
 
Rotate Element - Rotates an element(s). 

 
 
Scale Element - Resize an element(s) by the Active Scale factor or by points. 

 
Mirror Element - Mirrors an element(s). 

COPY ELEMENT

The Copy Element tool creates a duplicate of an existing element without affecting the original. It identifies 
the element to be copied with a data point and then enters a second data point at the location where the 
copy or copies should appear. Tool settings for Copy Element are listed below:
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Copies - The number of copies created is defined by the entered value.

Use Fence - The fence contents are copied. This option is grayed out until an active fence is placed 
in the file. The fence option dropdown list sets the Fence (Selection) Mode.

MOVE ELEMENT
Move Element - The Move Element tool relocates an element. After identifying the element to be moved, 
enter a second data point to define its new location. Additional data points continue to move the element 
until the reset command is issued.

The Tool settings for moving an element are described below.

Use Fence - If on, the fence contents are moved. This option is grayed out until an active fence is 
placed in the file. The fence option dropdown list sets the Fence (Selection) Mode.

SCALE ELEMENT 
 
The Scale Element tool is used to resize (scale) an element(s) individually, as a selected group, or within 
a fence. Scaling an element can be useful for changing the size of an element without having to redraw 
the element. Elements can be scaled in any or all of the three axis directions (X, Y and Z). 

NOTE      Elements may be selected individually, or multiple elements selected to scale in a 
selection set or by using the fence.
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Method - Defines how the elements are scaled

Active Scale - Method by which an existing element is scaled by the active scale factors (X Scale, 
Y Scale and Z Scale). If a scale factor is between 0 and 1 (for example, 0.25), the size in that direction is 
decreased; if a scale factor is greater than 1, the size in that direction is increased.

3 points - Method by which an existing element is scaled graphically, through the entry of three data 
points. The scale factors are computed by dividing the distance between the first and third points by the 
distance between the first and second points.

X Scale - Scale factor along view x-axis (horizontal), when method is Active Scale.

Y Scale - Scale factor along view y-axis (vertical), when method is Active Scale.

Proportional - If on, the element(s) proportions are maintained, when the 3 points method is used. 

About Element Center - If on, in the Extended Information section of the Tool settings dialog, 
the selected element(s) is scaled about its center point instead of a selected point. Cells and text 
elements are scaled about their origins.

Copies - If on, the element(s) are copied, and the copy(s) are scaled; the original(s) are not 
manipulated. The adjacent field sets the number of scaled copies to create.

Use Fence - If on, the fence contents are scaled. This option is grayed out until an active fence is 
placed in the file and the tool is selected. The fence option menu sets the Fence (Selection) Mode 
 
Scale Multi-line Offsets - If on, multi-line offsets are scaled (i.e., scaling the wall thickness when 
resizing a room). 

Scale Dimensions - If on, dimension values are modified to reflect the size of the scaled 
dimension.  If off, only the dimension elements are scaled, while the dimension value remains unchanged. 

Scale Annptations - If on, annotations are scaled.  If off, size of annotations remains unchanged. 
 
 
ROTATE ELEMENT

The Rotate Element tool is used to rotate. Elements can be rotated individually, as a selected group or 
within a fence.

Method - Defines how the elements are rotated.

Active Angle - Rotates elements by the Active Angle value, which can be keyed in.
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2 Points - Rotates elements by an angle of rotation defined by entering two data points.

3 Points - Rotates elements by an angle of rotation defined by entering three data points.

About Element Center - If on, in the Extended Information section of the Tool settings dialog, the 
selected element(s) is rotated about its center point instead of a selected point. Cells and text elements 
are rotated about their origins.

Copies - If on, the element(s) are copied, and the copy(s) are rotated; the original(s) are not manipulated. 
The adjacent field sets the number of rotated copies to create.

Use Fence - If on, the fence contents are rotated. This option is grayed out until an active fence is 
placed in the file. The fence option menu sets the Fence (Selection) Mode 

NOTE      Elements may be selected individually, or multiple elements selected to rotate in a 
selection set or by using the fence.
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MIRROR ELEMENT
This tool mirrors an element about one of three axes. Rather than manipulating the original element, 
enabling the Make Copy toggle creates a second occurrence of the element.

 
 
Mirror About - Sets direction in which element(s) are mirrored: 
 
Horizontal - Elements are mirrored about the horizontal, or X, axis. 
 
Vertical - Elements are mirrored about the about vertical, or Y, axis. 
 
Line - Elements are mirrored about a line defined by two data points. 
 
About Element Center - If on, the selected element(s) is mirrored about its center point 
instead of a selected point. Cells and text elements are mirrored about their origins. 
 
Make Copy - If on, the element(s) are copied, and the copy(s) mirrored; the original(s) are not 
manipulated. 
 
Use Fence - If on, the fence contents are mirrored. This option is grayed out until an active fence is 
placed in the file. The fence option menu sets the Fence (Selection) Mode. 
 
Mirror Multi-line Offsets - If on, multi-line profile offsets are mirrored. 
 
Mirror Text - If on, text is mirrored.
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EXERCISE OVERVIEW

Exercise 8.1Exercise 8.1   Manipulate Tools

 
COPY ELEMENT
1.	 Construct an edge of pavement line.

2.	 Open the OpenRoads Designer file c:\e\projects\22049555201\SURVRD01.dgn.

3.	 Using the View Tools, rotate and zoom the view as shown and locate the left turn to the west of the 
main intersection in the design.

4.	 Locate the Manipulate Tools on the Ribbon and select Copy Element.

file:///c:\e\projects\22049555201_CE\SURVRD01.DGN.
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5.	 Using the Copy Element Tool, select one of the left turn arrow pavement markings from the left turn lane 
west of the intersection. A copy of the element attaches to the cursor.

6.	 Place the copy adjacent to the left turn arrow located in the left turn lane east of the intersection, 
entering a data point to complete this action and selecting the Reset button to end the action.

 

ROTATE ELEMENT
1.	 Continuing at the same location, use the Element Selection Tool to select the copy of the left turn 

arrow that was just placed in the previous exercise.
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2.	 Select the Rotate Element Tool from the Manipulate Tools on the Ribbon. Populate the dialog as 
shown below.

3.	 Enter a data point to accept. The left turn arrow will rotate 180 degrees.

ROTATE ELEMENT
1.	 Continuing at the same location, select the Move Element Tool. Enter a datapoint on the arrow that 

was rotated in the last exercise, and move the cursor downward to move the pavement marking into 
the desired location.

2.	 Enter a data point to accept the new location.
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9  CELLS

OBJECTIVES
This chapter reviews OpenRoads Designer Cells and Points. Topics include:

•	 Cells
•	 Cell Libraries
•	 Cells and the FDOT Ribbon
•	 Dropping Cells
•	 FDOT Cell Webpages

INTRODUCTION
As project designs are created, users often have to place points to construct elements from or place multiple 
instances of the same symbol in the design file. OpenRoads Designer stores such points and symbols efficiently. 
The symbols are referred to as Cells. OpenRoads Designer stores cells in cell libraries so that they may be 
recalled as needed. Florida Department of Transportation (FDOT) has utilized this function and developed 
many Standard Cell libraries for specific use by each FDOT Discipline in the production of FDOT Projects. 
These Standard Cell Libraries are delivered within the FDOT CADD Software package and will be discussed 
in more detail later in this chapter.

CELLS
Typically, a Cell is a small 2D drawing, or a 3D object. Cells can represent complex elements that are used 
regularly in designs. Rather than redraw them each time, they can be saved in a cell library to recall for 
repeated use. Cell libraries are really DGN files that contain one or more models, one for each cell. The 
cells are simply design models that have the option ‘Can be placed as a cell’ enabled. Cells created in this 
fashion have the model´s origin as their origin.

FDOT has created many cells as a part of the CADD Software delivery to assist the user in the production 
of FDOT projects and adhering to the CADD Standards.

Sample Cells



CADD Essentials 90

CREATING CELLS
This chapter, thus far, has discussed utilizing existing cell libraries containing pre-defined cells. In actual 
working environments, users will likely have to create cells and then use those cells in their drawings.

If a cell is needed, but one cannot be added to a cell library (because, for example, a system administrator 
is in charge of the cell libraries in the company), consider using a Group to place the same elements 
repeatedly in a design. A Group is complex element whose component elements need not be connected 
(an unnamed cell that is not defined in a cell library). A number of elements can be selected and grouped 
for manipulation as a single element.

When a cell is created, define the cell origin (the location around which the cell is placed).

A Graphic Cell is a type of cell in which the symbology (color, line style, and line weight) is determined when 
it is created. They are stored with symbology settings and are always placed with their original attributes. A 
graphic cell rotates when a view is rotated. A graphic cell is level independent. That is, it can be placed on 
levels relative to the Active Level or on the same levels as when created, depending on whether Relative 
is on.

CELL LIBRARIES
Cell libraries are commonly stored as a DGN with the extension .CEL instead of .DGN, and can be opened 
as a DGN file. Each model in these cell libraries file becomes a separate cell. When a cell library is created, 
a blank default model is created. This blank model displays when first opening the cell library as a DGN file. 
Change to different models with the Models dialog (File > Models).

With OpenRoads Designer there is no limit for the size of a cell library or individual cells. This means 
that the requirements of the operating system set the limit, including the maximum number of characters 
allowed in a cell name. Both 3D cells and 2D cells can be stored in the same library.

The FDOT CADD Software delivers an extensive array of cell libraries containing standard FDOT cells 
associated with all Discipline functionality, that are required to produce FDOT design files. The FDOT 
Ribbon includes access to the FDOT cell libraries in the Cell Library dialog as well as Cell Webpages for 
accessing the FDOT cells in a web-browser interface.

CELL LIBRARY DIALOG
To utilize any cell within a design the associated Cell Library containing the cell must be attached to the 
active design file. The Cell Library dialog is used to Attach Cell Libraries and activate different types of 
cells, and to create, delete, and rename cells in the attached cell library, if one is attached. The name and 
path of the attached cell library, if one is attached, are displayed in the title bar.

The Cell Library dialog can be accessed from the Cell Applications section of the FDOT Ribbon. Selecting 
the Cell Libraries split button provides access to commonly used FDOT cell libraries.
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Selecting one of the cell libraries will attach that cell library and display the cell library dialog.

File Menu Options

	● New - Opens the Create Cell Library dialog, which is used to create a cell library and attach it to the open DGN 
file.

	● Attach File - Opens the Attach Cell Library dialog, which is used to attach an existing cell library to the open 
DGN file.

	● Attach Folder - Opens the Browse For Folder dialog, which is used to attach a folder containing cell 
libraries to the open DGN file.

	● Detach - Detaches the attached cell library. Attaching a different cell library automatically detaches the 
currently attached cell library, if one is attached.

	● Compress - Compresses the open cell library. Compression reorganizes the cell DGN file to occupy the 
minimum disk space.
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List Box Headings - The List Box Headings set the order in which the cell list is sorted. All columns 
are sorted alphabetically. Clicking a column’s heading sorts the list in ascending or descending order by 
that column.

	● Name - Cell Name

	● Description - Cell Description

	● Type - Cell type: Graphic (Grph), Point (Pnt), or Menu

	● Annotation - The annotation icon appears if the cell is an annotation cell.

	● Where - Cell location: cells in AutoCAD DWG block file (BLCK), cells in an attached cell library 
(Lbry), shared cells in the attached cell library (LbSh), or shared cells in the active DGN file (Shrd).

List Box - The List Box lists the name, description, type, annotation, and location of cells that are 
available for placement from the attached Cell Library. They are listed in the order specified by the 
selected list box heading. To work with a cell, select its list item. When selecting a cell, it is displayed to 
the right of the list box with its name, type, and size. For a 3D cell, the isometric, top, front, and right views 
are shown.

Active Cells Toolbar – The Active Cells Toolbar allows the selection of cells for various purposes. Active 
Cell, Point Cell, Terminator Cell and Pattern Cell. To set an active cell, select the cell from the list box and then 
select the corresponding button on the toolbar to activate that cell. A symbol is placed to the right of the cell in 
the List Box to indicate that it is active.

Active Cell – This cell can be placed with the Place Active Cell tool

Point Cell – This cell can be placed as a point using tools that place point cells such as the 
Import XYZ text tool

Terminator Cell – This cell can be placed as a terminator arrow for a line by tools that place 
terminator arrows on lines

Pattern Cell - This cell can be used for patterning areas using the Pattern Area tool.
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Create - The Create  button opens the Create New Cell dialog, which is used to add a cell

to the attached cell library. This button is dimmed unless the following conditions are met:

ü	A cell library is attached (File > Attach) with write access.

ü	The elements to be included in the cell are selected or fenced.

ü	A cell origin is defined with the Define Cell Origin tool.

 
PLACING CELLS

Users insert cells in a drawing in much the same way as other OpenRoads Designer elements. The 
size
(scale) and rotation angle are specified at the time of insertion. To place a cell into a drawing:

	● Attach a Cell Library

	● Select a Cell

	● Make the Cell Active

	● Select a Cell Placement Tool

	● Adjust the Scale and Rotation of the Cell as needed

	● Identify a Location for the Cell 

CONTROLLING THE LEVEL
When placing a graphic cell with the Place Active Cell tool or Select and Place Cell tool, the level(s) on 
which the graphic cell are placed in the open DGN file are determined by first evaluating the level(s) on 
which the elements in the graphic cell resided when the graphic cell was created and then applying the 
Relative tool setting.

If Relative is off, the Name of the level(s) on which elements in the graphic cell resided when the cell was 
created determine the level(s) on which the graphic cell is placed, as follows:

	● Level Existing - If the graphic cell has elements on a level with the same name as an existing 
one in the DGN file, the elements in the graphic cell on that level are placed on the corresponding 
level in the DGN file, even if the level settings are not the same.

	● Level Non-existing - If a level with the same name does not exist in the DGN file, the level 
is copied from the cell library into the DGN file. However, any elements in the graphic cell on the 
Default level in the cell library are placed on the Active Level.

	● If Relative is on, the Number of the level(s) on which elements in the graphic cell resided when the 
cell was created determine the level(s) on which the graphic cell is placed, as follows:

	● Level Existing - The graphic cell is placed on a level(s) relative to the Active Level’s number. 
For example, consider a graphic cell that was created with elements on levels with the numbers 5, 
7, and 8. If the Active Level’s number is 1, the cell is placed on levels with the numbers 1, 3, and 
4. If the Active Level’s number is 45, the cell is placed on levels with the numbers 45, 47, and 48.

	● Level Non-existing - However, if the graphic cell has elements on any level whose number 
is not an attribute of a level in the DGN file, the placement operation fails.

mk:@MSITStore:C:/Program%20Files/BentleyXM/Documentation/MicroStation.chm::/ustnhelp1721.html#J12220
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CELLS

Cells are placed primarily using the Place Active Cell tool. This tool is located on the Drawing tab in the 
OpenRoads Modeling workflow under the Placement group of the Ribbon. 
 

 
 
Active Cell - Can be keyed-in here or set in the Cell Library dialog (Element > Cells).

Browse Cells - Opens the Cell Library dialog to allow for selection of an active cell.

Active Angle - Set the angle by which the cell is rotated, if Interactive is off, or if Interactive is on and Scale Only 
is selected.

 
X ,Y, Z Scale - X - Horizontal scale factor (along x-axis). Y - Vertical scale factor (along y-axis). Z - Depth scale 
factor (along z-axis).

If scale lock is on, then all scales will hold the same value. 

If scale lock is off, then each value is independent of the other. .

Annotation Scale Lock - (Applies only to cells that have Can be placed as an annotation cell enabled in 
their Model Properties.) 
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   If display highlight is on, the current annotation scale is applied to the cell. Later, if the annotation scale is 
modified, the option is given of having the new scale applied to previously placed annotation cells.

True Scale - If on, cells that were created in a model with different units from those of the active model are scaled 
to adjust them to the units of the active model

Relative - If the active cell is a graphic cell and Relative is ON, the Number of the level(s) on which elements in the 
graphic cell resided when the cell was created determine the level(s) on which the graphic cell is placed. The graphic 
cell is placed on a level(s) relative to the Active Level’s number.

If the active cell is a graphic cell and Relative is OFF, the Name of the level(s) on which elements in the graphic cell 
resided when the cell was created determine the level(s) on which the graphic cell is placed.

Mirror - If on, when placing a cell it can mirrored about the horizontal axis, about the vertical axis, or about both the 
horizontal and vertical axes by selecting one of these options from the list box.

Interactive - If on, the cell’s scale, rotation angle, or both scale and rotation are defined graphically by data points.

Rotate and Scale — If on, both the scale and rotation angle are defined graphically by data points.

Rotate Only — If on, the rotation angle is defined by placing a data point. The scale is defined in the X 
Scale, Y Scale, and Z Scale text boxes.

Scale Only — If on, the scale is defined by placing a data point. The rotation angle is defined in the 
Active Angle text box.

Flatten - If on, 3D cells can be flattened, or projected, on to one of the standard view projections — Top, Front, Right, 
Isometric, Bottom, Back, Left, Right Isometric — which is selected from the option menu. Allows for placement of a view 
of a 3D cell into a 2D model.

Scale Multi-line Offsets, Dimension Values and Annotations  - If on, applies the active 
scale to multi-line offsets, dimension values and annotations. 
 
If off, the active scale is not applied. This setting does not affect multi-line offsets, dimension values and annotations 
in shared cells; elements in shared cells always scale. This setting is also available in the Scale tool.

The Define Cell Origin - tool is used to define the cell origin (the point about which the cell is 
placed). When creating a cell, the cell origin and cell type is defined. Notice the OpenRoads Designer 
message in the lower left status bar.

The Place Active Line Terminator -  tool is used to place the Active Line Terminator cell on a 
line, line string, arc, or complex chain, primarily to place arrowheads. 
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CELLS WEBPAGES 
 
Also located in the Cell Applications on the FDOT Ribbon are the FDOT Cell Webpages.  The Cell 
Webpages provide a web-browser interface for previewing, selecting, and placing cells. The Cell Webpages 
are intuitively organized by Cell Library name. 

 
 
CELL SEARCH
This utility searches selected cell libraries for a text string and returns the matching cells in a second 
dialog from which the cells can be placed. It searches the cell name and\or description of each cell in the 
selected cell library. 
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Attach a Cell Library and Place a Cell

From the FDOT Desktop folder launch FDOT Connect for OpenRoads Designer and open c:\worksets\
FDOT\roadway\dsgnrd01.dgn within the FDOT WorkSpace. Select the FDOT tab on the Ribbon and 
select the Cell Libraries split button from the Cell Applications section. Select Roadway.

The Cell Library dialog appears, and the FDOT Roadway Cell Library is attached. 
Select the cell BarScale50 and select the Set Active Cell button as shown.

Navigate to the Place Active Cell tool on the Drawing tab under the Placement section.

file:///c:\worksets\FDOT\roadway\dsgnrd01.dgn
file:///c:\worksets\FDOT\roadway\dsgnrd01.dgn
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Review the settings in the Place Active Cell tool settings dialog.

Enter a datapoint anywhere in the design to place the BarScale50 cell.

CREATING AN PROFESSIONAL OF RECORD SEAL CELL
One common use of cells is the Professional of Record Seal cell that appears on signature sheets and key 
sheets adjacent to the digital certificate appearance of the professional of record. FDOT delivers several 
different cells in the Seals.CEL library for the user to modify and use.

From the FDOT Ribbon, select the Explore Directories split button and select FDOTConnect.

A Windows File Explorer window opens at C:\FDOTConnect\Organization-Civil\

Navigate to C:\FDOTConnect\Organization-Civil\FDOT\Cells\ and locate the Seals.CEL library.

Right-click on Seals.CEL and select Copy from the right-click pop-up menu.

file:///C:\FDOTConnect\Organization-Civil\
file:///C:\FDOTConnect\Organization-Civil\FDOT\Cells\
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10  REFERENCE FILES

OBJECTIVES
This chapter reviews the Referencing tools. Topics include:

	● What is a Reference File?

	● References

	● Attaching References

	● Working with References

INTRODUCTION
In the past designers were often asked to use an existing drawing as a backdrop as they created new 
drawings. They taped the existing drawing down onto their drafting table, and then taped a clean sheet 
(new design file) on top of the existing drawing (reference). This procedure of working over a backdrop is 
still used today with automated techniques. In today’s industry, individual members of a project team share 
electronic data files rather than the actual drawing sheets they used to share.

Several companies may be involved in producing a design which includes many information types such as 
Survey (existing topography), Proposed Construction, Drainage and Right of Way. Design files are passed 
back and forth between all team members and all the pieces of the puzzle must fit together. Assume 
the responsibility for the Proposed Roadway construction portion of the plan. Since the design must fit 
within the Right of Way and meet the Existing Construction at the beginning of the project, the location of 
these elements must be known. In this case, the topographical plan must be seen in the background as a 
reference while designing the roadway plan. OpenRoads Designer does this with references.

OpenRoads referencing tools allow the user to view other models as work is done on the active model, 
much the way overlays are used in the real world. With overlays, work is done on the top overlay, while 
referring to the information on one or more overlays below.

WHAT IS A REFERENCE FILE?
A Reference File is a model attached to and displayed with the active model for printing or construction 
purposes. A model that resides in the open DGN file, or another DGN file can be attached as a reference 
file. Elements in a reference file display as though they are in the active model. Although elements cannot 
be manipulated in a reference, users can snap to and even copy elements in a reference into the active 
model. Reference files cannot be modified.

OpenRoads Designer allows for an unlimited number of files to be referenced to a design file, as the 
operating system and hardware limit the number of reference files allowed. When a file is referenced, a 
link is established to it. If the referenced file is edited, then the file that it is referenced to updates to reflect 
those changes.

REFERENCES
The References dialog attaches and detaches referenced models to an active design model, has a number 
of settings that control the attachments and displays of references in a model and allows for the selection of 
reference tools.
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The References dialog can be accessed from the Primary tools on the Home tab of the Ribbon under the 
OpenRoads Modeling workflow from the Attach Tools split button.

 
 

 
The References dialog can also be accessed by right clicking on the active file listing in the Level Display 
dialog, also located in the Primary tool bar.
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TOOLS MENU
 
The References Tools menu option provides tools for working with references. Many of these tools can 
also be accessed by selecting the Tool icons below the References menu bar. 
 

 
 
SETTINGS MENU 

The References Settings menu option provides links to adjust settings for the attached reference files.
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LIST BOX (RIGHT-CLICK) MENU
Right-clicking on a file name in the References List Box opens a popup menu that directly accesses 
options available in the Tools and Settings menus:
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SHOW HIERARCHY AND LIST BOX

The Show Hierarchy icon  is a toggle to display a tree showing the active design file with all attached
references. References that have other references attached to them (nested references) are listed in 
black text, while references with no attached references are listed in gray text.

If a reference in the hierarchy has a nest depth value of 1 or more, the reference can be selected to 
update the References List Box to include only the references that are attached to the selected reference.

When toggled off, the arrow button next to the Show Hierarchy icon can be used to list the active file and 
any attached references for selection to update the References List Box.

The References List Box displays columns containing many settings. The columns can be modified by the 
user, either by clicking them (for toggle settings) or by clicking them and selecting a new setting or value.

The columns displayed can be modified by right clicking on the column header and selecting or 
deselecting column options as shown.
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REFERENCE DIALOG ICONS

The References dialog icons are used to: Attach referenced models to the active model; Control the 
positioning, scaling, clipping, and orientation of attached referenced models; and Detach referenced models 
from the active model.

Attach Reference - Opens the Attach Reference dialog, which allows for the attachment of a model 
to the active model. 

Clip Reference - Uses a boundary, such as an element or fence, to clip a reference. The area of the 
reference outside the boundary is not displayed. 

Mask Reference - Covers a portion of a reference that is inside a boundary. More than one clipping 
mask can be specified for a model. 

Delete Clip - Deletes an existing clipping mask. 
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Set Ref Back Clip Z (3D Files Only) - Sets the back clipping plane, a boundary used to clip 
a referenced 3D model. The position of the clipping plane is measured along the z-axis. Only the area in 
front of the back clipping plane is displayed. 

 
Set Ref Front ClipZ (3D Files Only) - Sets the front clipping plane, a boundary used to clip 
a referenced 3D model. The position of the clipping plane is measured along the z-axis. Only the area 
behind the front clipping plane is displayed. 

 
 
 
Reload Reference - Reloads and redraws a reference, allows the user to view changes made to the 
referenced model since it was last attached or reloaded. 

Move Reference - Moves the location of the reference file in the design file. 

Copy Reference - Copies the reference file. 

Scale Reference - Resizes the reference file. 

Rotate Reference - Rotates the reference file. 

Mirror Reference - Reflects a reference file about a horizontal or vertical axis. 

Copy/Fold Reference  - Copies the selected reference file, and then attaches a view by folding it 
about an orthogonal axis or a defined line. 

Set Reference Presentation - Sets options for displaying a reference file, such as 
Wireframe, Hidden Line, Filled Hidden Line and three types of shading. 

Detach Reference - Detaches the reference file from the active model. 
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INFORMATION PANEL
The References Information Panel, located at the bottom of the References dialog, displays the various 
settings for an attached reference selected in the References List Box. The options displayed in the 
Information Panel can be modified by right clicking anywhere on the panel and selecting or deselecting any 
option from the popup menu. The table below describes each option.

 
 

 
 
SCALE - Displays and sets the ratio of master units in the active model to the master units in the attached model. 
 
 
 
ROTATION - Displays and sets the rotation for the selected reference. For 2D files, enter the rotation 
angle for the z-axis only. In 3D, enter the rotation angles for the x-, y- and z-axes.

 
 
 
OFFSET - Displays and sets the distance between the global origin of the reference from the global 
origin of the parent file, measured in units of the parent file. If the parent is 2D, Offset X and Y values are 
displayed. If the parent is 3D, Offset X, Y, and Z values are displayed.

 

 
 
NESTING - Nesting displays and sets how nested references (references attached to references) are 
handled for the selected attachments.  When working in a DWG or DXF file, live nesting is always on with no 
limit to nest depth. Therefore, the nested attachment and Depth items are disabled. To control the display 
of nested attachments, use the Ignore Attachment When Live Nesting icon. 

Overrides controls how override settings are saved for nested references. For a specific nested reference, 
overrides controls the settings for reference display, locate, snap, raster reference display, and level display.  

Depth sets the number of levels of nested references that are displayed. Models can have their own 
referenced models, which, in turn, can have more referenced models. If Depth is set to 0, only the selected 
model is attached to the master model; models referenced to the selected model are ignored.

 

 
NEW LEVEL DISPLAY - Specifies whether a reference displays new levels. The setting also applies 
to new levels in nested references that are attached to the reference.

 
 
 
TOGGLES - These toggles are Attachment Settings icons that correspond to columns in the References 
List Box, as well as to icons on the Reference Attachment Settings dialog.  If an icon is highlighted, the 
setting is on. Click the icons to toggle the settings on or off.

 
 
 
GEOREFERENCED - Sets the georeference mode. When a reference is attached in Reprojected 
mode, the current Reference Reprojection Settings are copied into the reference attachment and stored so 
every user who opens the master file uses the same Reprojection settings and thus, gets the same results. 
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HILITE MODE 
 
The Hilite Mode controls whether the selected references are highlighted and/or surrounded by a border. 
 
 

 
None – Selected references are not highlighted in any way.

Boundaries – Places a dashed border around selected references.

Hilite – Highlights selected references.

Both – Places a dashed border and highlights selected references 
 
 
ATTACHING REFERENCES
 
OpenRoads Designer referencing tools allow viewing of other models while working on the active 
model, much the way overlays are used in the real world. With overlays, work is done on the top overlay, 
while referring to the information is done on one or more overlays below.  Models can be referenced 
from the open DGN file, or from other DGN’s that may or may not currently be opened by other 
users. Similarly, other users can reference the active model. Referencing is a powerful tool in a multi-
discipline office, in particular, where many people are working on different aspects of the same project. 
 
 
The References menu option: Tools > Attach, <OR> clicking the Attach Reference  icon, opens 
the Attach Reference dialog for selecting model(s) to attach to the active model.  Multiple files from 
multiple locations may be attached at the same time by selecting and adding to the Selected Files box. 
 

Upon completing the selection of attachments the Reference Attachment Settings dialog opens to set the 
attachment settings for the reference(s) selected. If multiple files were selected, this dialog will open for 
each one to set the attachment settings.
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File Name - Shows the reference’s name.

Full Path - Shows the full file path for the reference.

Model - Drop down list of the models contained in the reference. This is used to select the model to be attached to 
the master model.

Logical Name - Sets the logical name of the model. Since the same model can be attached many times, the 
logical name helps distinguish between references.

Description - Sets the optional description for the model. The maximum valid description is 40 characters.

Orientation - Sets the view of the model being attached. The list may also include saved views and named 
fences. More than one orientation can be selected to attach.

Coincident - Aligns the references with regard to design plane coordinates only.

Coincident World - Aligns the references with the active model with regard to both Global Origin and design 
plane coordinates. FDOT recommends using the Coincident World option when attaching reference, to ensure 
files from an older standard line up correctly when attached to a file with the current working units. FDOT 
CADD files created in OpenRoads Designer have different resolutions than OpenRoads Designer V8.

Standard Views - Identifies the views that can be used to display the reference: Top, Front, Right, Isometric, 
Bottom, Back, Left, or Right Isometric. If the file being attached is 2D, only the Top view can be selected. 
 
Saved Views - Identifies the saved views that are available in the reference.

Named Fences - Identifies the named fences that are available in the reference. When a named fence is used 
to attach a reference, all levels are on. If a particular level is desired, then use the named fence as a clip 
volume for a saved view in the reference and select the saved view.

Detail Scale - Represents the Master:Ref scale in terms of the sheet scale. For example, if the sheet scale 
(annotation scale) is 1/8” = 1´ and a detail reference of scale 1/4” = 1´ is to be placed, select the new scale from the 
Detail Scale drop-down list. It automatically computes the Master:Ref scale as 2:1.
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When attaching a reference (a design or drawing model) into a sheet model, the referenced model’s annotation scale 
is applied as the detail scale, and the Reference Scale (Master:Ref Scale) is calculated from the referenced model’s 
annotation scale and the active model’s annotation scale.

Scale (Master: Ref) - Sets the ratio of the master units in the active model to the master units in the 
attached model.  
 
Named Group - Identifies a named group used to limit the elements displayed in the reference.  
 
Revision - If Design History is on in the referenced model, allows for the choice of the revision to reference.

Level - (DWG Work Mode only) Sets the level for the reference to be attached. In an AutoCAD DWG or DXF 
file, each XREF or layout viewport is placed on a specific layer. When a DWG file is opened in OpenRoads 
Designer, XREFs and layout viewports are treated as references, and placed on the same level (layer). To 
modify a reference’s level, open the References dialog, double-click on the reference to open the Attachment 
Settings dialog and modify the Level setting. If a level is frozen, references on that level are not displayed. 
 
Nested Attachments -  Determines how nested references (the references attached to the model selected 
as the reference) are handled for this reference attachment.

No Nesting - Nested references are ignored for this attachment.

Live Nesting - The hierarchical structure of any nested references are maintained when attaching the reference. 
The child references are displayed if the nest Depth is set high enough and it does not have the Ignore 
Attachment When Live Nesting setting turned on.

All of the nested attachments display in the view window; however only the parent reference in the References list box. 
To see the hierarchy of nested references, use the Show Hierarchy icon on the References dialog.
 
Depth - Sets the number of levels of nested references that are displayed. Child references can have their own 
referenced models, which, in turn, can have more referenced models, and so on.
 
If Depth is set to 0, only the model is attached to the master model; referenced models in the referenced model are 
ignored.
 
Display Overrides - Controls how overrides are saved for nested references. For each nested reference, 
overrides allow for the control of the settings for reference display, locate, snap, raster reference display, and level display. 
 
New Level Display - Specifies whether a reference displays newly created levels. The setting also applies to 
new levels in nested references that are attached to the reference.
 
Global Line Styles - Controls the scaling of custom line styles. Every model can have a global line style scale 
factor that is applied to every line style within the model. This factor is set in the Element Attributes category of the DGN 
File Settings dialog (Settings > Design File).
 
Alternatively, use the ACTIVE LINESTYLESCALE key-in to set the global scale factor for custom line styles. The 
specified scale factor has the same effect as the Scale Factor setting in the Line Styles dialog.
 
 
Synchronzie with Saved View - This  check box, when turned on, will synchronize saved view 
attachments with the original saved view. In order to change the appearance of a reference, the saved view that it is 
synchronized with must be modified. This is to ensure fidelity of display properties such as view attributes, level masks, 
clip volume, display styles and others.               
Toggles - Defines settings for the reference. The icons correspond to columns in the References List box and 
Information Panel. If an icon is pressed, the setting is on. Click the icons to toggle the settings on or off. These are the 
same toggles found on (and described earlier) the References Information Panel.

Drawing Title - When attaching a reference on a sheet, a drawing title can optionally be created. A drawing title 
describes a drawing on a sheet.

Create – Toggle to turn on the option to create a drawing title. 
 
Name – Enter a name for the drawing title, when Create is toggled on.
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WORKING WITH REFERENCES

CLIPPING AND MASKING REFERENCES
The user can control the reference display more precisely by using the clipping tools:

Clip Reference -  This tool allows the use of a boundary, such as an element, cell, or fence, to clip 
a reference. When a reference is clipped, the area of the reference outside the selected boundary is not 
displayed.

Clip Mask - This tool allows the use of a fence to cover or not display a portion of a reference. 

Reference elements display only inside the clipping boundary and outside all clipping masks. Both clipping 
boundaries and clipping masks are on the same reference tool to control the display more precisely. With 
the Boundary Display attribute turned ON in the View Attributes dialog, reference clip and clip volume 
boundaries display for that view. Reference clipping is defined relative to the world coordinates, and the 
clipped volume will therefore remain the same in all views. The boundaries of a saved view can be used as 
the clipping boundary when a reference is attached.

MANIPULATING REFERENCES
Users can manipulate references with the standard manipulation tools, or perform these tasks with tools 
specifically designed for reference manipulation. Whichever method the user employs, the manipulation is 
for the reference attachment as a whole. Individual elements cannot be manipulated in a reference unless 
it is changed to the active model.

When changing the active model to a referenced model, it will appear as it was saved (Save Settings). 
There are two simple methods to activate a reference while maintaining the current view orientation:

•	 Temporarily activate the referenced model in-place. Use this method when snapping to elements 
in the active model.

•	 Make the referenced model the active model by exchanging to it. Use this method when focusing 
only on that model.

USING REFERENCE TOOLS TO MANIPULATE REFERENCES 
Tools in the Reference Dialog toolbar allow for manipulation of references directly. The user can use these 
tools whether or not the Treat Attachment as Element for Manipulation setting is enabled.

Every reference manipulation tool can contain any or all of the following tool settings.

•	 If Move Boundary with Reference is on, then any clip boundaries/masks are manipulated with the 
reference. If this setting is off, then the reference is manipulated, while the clip boundaries/masks 
remain static.

•	 If Use Reference Dialog List is turned on, the manipulation works on the models selected in the 
References dialog.

•	 If a fence exists and Use Fence is turned on, any models that are in the fence are manipulated. If a 
selection set has been created, manipulation works on the models in that set.

EXCHANGING TO A REFERENCES 
There may be times when the current view orientation needs to be maintained, but focus exclusively on the 
referenced model. In this situation, the Exchange option may be preferable.
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To exchange the referenced model for the active model:

•	 In the References dialog, select the reference then choose Tools > Exchange.

•	 Right-click the reference in the References dialog, then select Exchange from the pop-up menu.

•	 With the Element Selection tool, point at the referenced element and choose Exchange from the 
Reset pop-up menu.

•	 Use the key-ins REFERENCE EXCHANGE <file_name, model_name>, or XD= <file_name, 
model_name>.

When using the key-ins, including the file name, model name, is optional. When using a key-in to exchange 
to a reference:

•	 Select the reference graphically (by not specifying a file name, nor selecting a reference in the 
References dialog).

•	 Include the reference filename and, where necessary, model name.

•	 Select the reference in the References dialog, prior to using the key-in.

MERGING REFERENCES INTO THE ACTIVE MODEL 
The contents of one or more references can be merged into the active model. The levels of elements in 
the attached reference are copied to the merged file only if they do not exist in the active model.

 
NOTE    Only the displayed elements in the reference are merged into the active model

ATTACHING SURVEY REFERENCES
FDOT has created a custom tool to attach the SURVRD file which contains the existing features (TOPO), 
existing drainage (DREX), existing utilities (UTEX) and digital terrain model (GDTM) information. The 
Attach Survey Reference tool, located on the Ribbon under the FDOT tab in the Roadway section, is 
designed to locate the SURVRD file, attach it four times, and apply logical names and level filters to each 
attachment. The result is that the four aspects of the SURVRD are effectively attached individually for 
easier manipulation.

These four attachments can now be turned on and off individually. The logical names allow the FDOT 
Gray Existing pen table and plot configuration to apply a 50% halftone shade to the contents of the 
SURVRD file for sheet composition and printing. 
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EXERCISE OVERVIEW

Exercise 10.1Exercise 10.1   Reference File Attachment

1.	 Open the file named c:\worksets\FDOT\22049555201\roadway\dsgnrd02.dgn, which is a blank file 
created earlier in this training guide.

2.	 From the Primary Tools on the Ribbon, open the References dialog by selecting the Attach Tools 
split button and selecting References. 
 

 

file:///c:\worksets\FDOT\22049555201_CE\roadway\dsgnrd02.dgn
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3.	 In the References dialog, select the Attach Reference icon..

4.	 In the Attached Reference dialog, ensure that the Files of type: is set to CAD Files (*.dgn;*.dwg;*.
dxf); expand the Select Files list box by clicking the arrow below the Files of type; set the Attachment 
Method to Interactive; navigate to the c:\worksets\FDOT\22049555201\roadway\ directory and select 
the algnrd01.dgn file to attach as a reference. Click Open

5.	 From the Reference Attachment Settngs dialog, set the Model to Default from the drop down arrow; 
enter Alignment for the Logical Name; and ensure the remaining settings are set as shown below. 
 
NOTE       The Model dropdown list is populated based on the file selected.  
 
 

6.	 Click OK to accept.

file:///c:\worksets\FDOT\22049555201_CE\roadway\
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7.	 From the View Control at the top of View 1, select the Fit View icon. Notice the elements that were 
added to the file.

8.	 Close the References dialog.
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Exercise 10.2Exercise 10.2   Attach Survey Reference Files

1.	 Continuing in the same file, locate the Attach Survey Reference tool on the Roadway section of the 
FDOT Ribbon.

 

2.	 Select Attach Survey Reference. This tool may take a moment to complete the process.

3.	 When the process is complete, inspect the References dialog to see the four attachments of the 
SURVRD file and the applied logical names.

4.	 Close the References dialog an exit OpenRoads Designer.
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